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Supply Teacher Database
For: Supply Teacher Bookings AND

Timesheets for Supply Teachers / Permanent Teacher Additional Hours
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Introduction

This guide will provide information on how to use the Supply Teacher Booking Database
which is used to book out and create timesheets for Supply Teachers working in EDC
schools, as well as timesheets for any permanent teachers who work additional hours.

High level steps within booking & timesheets processes:

Supply Booking / Teacher Attendance Return Process (For Supply Teachers & Permanent Additional Hours)
o
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How to access the database

To access the database, you will first need to connect to a RDP Server.

Loqgging in to the RDP Server

This requires you to log in to an application on your computer before logging in to the
database. IT will have set this up for you and created a shortcut on your desktop in which to
access the server. *Please note: New members of staff will need to contact IT Service
desk to be given access to the server*

1. Click on the shortcut EDU-FMS-RDS (it may also be called FMS
Remote Desktop and can be found in your Staff folder)

EDU-FMS-RD
S

2. Onthe log in screen that appears, enter your user name and password. The password
should be the same one you use to log in to your computer, and so should your
username except with the characters sch\ before it, demonstrated in the picture below.

Windows Security X

Enter your credentials ] )
To log in to a different account, select More

These credentials will be used to connect to 10.200.10.192. ChOiceS > Use a different account

sch\025ebell

I:l Remember me

More choices

oK Cancel

Once you are logged in to the RDP Server, you will then be able to access
the database via the shortcut on your desktop
Supply
Te;cl}hh::r

Database -
LIVE

*PLEASE NOTE* When you have finished in the RDP Server, you must
ensure you log out of the server by clicking the red LOG OFF icon.

LOG OFF
HERE
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Logging in to the database for the first time
A username will have already been set up for you to . P '
use the database, however when logging in for the first
time you will need to set your own password. Supply Teacher DB

1. On the log in page, click Reset Password py—

€ passworc

Remember username

On the next page there are three steps you need to follow:

Step 1.

U=ername

Enter your username in the field above and click the Request

Code button.

Request Code

The username that has been set up for you should be your first initial and surname in
capitals e.g. JSMITH, check with your SSC/SSM to confirm. Enter this in to the
Username field then click Request Code, then go and check your e-mail inbox.

Step 2.
Enter code here

Check your email inbox, you should shortly receive an email
with a code. Type this in the Enter code here field. then click
the Submit Code button.

Submit Code
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You will receive an e-mail from a
do_not_reply address providing you with a
code made up of both upper and lower case
letters. Copy the code exactly and paste it in
to the Enter code here field, then click
Submit Code. If you do not receive a code
then please contact your SSM/SSC as your
e-mail address may have been entered
incorrectly when setting up your access.
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" Supply Teacher Database - Password reset code

do_not_reply to
Rt

Supply Teacher DatabasePassword Reset foobar

A request for a password reset has been made from the system.
If this is a valid request, please enter the code shown below.
Otherwise, contact the System Administrator.

The reset code is:

Step 3.

Mew Password

Confirm Password

your password.

Reset Password

Enter a new password and then type it again in the Confirm

Password field. Press the Reset Password button to change

Once the code has been submitted successfully, you will then be asked to set your new
password; once you have done this click Reset Password.

How to reset your password

If you have forgotten your password and need to reset it, please follow the same process as
above to create a new one, however do not log out of the database as you will have to

reset the password again

You can now return to the database log in page and using your username and new
password can now gain access to your account, where you will be taken to the Home Page

of the Supply Teacher Database.

= Supply Teacher Database

2 Home

Welcome to the Supply Teacher Database
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Administration Functions

School Support Managers and Co-ordinators will have Administration access which will allow
them to add a new user.

How to add a new user

1. To create profiles for staff members, click on the down arrow next to Administration on
the left hand side of the screen, then click User Administration from the menu that
appears. Once on the User Administration page click Add User.

'L'§3 Administration

(23] User Administration S

Qv Go Actions ~ | Add User
Manage Lock Up Values

5 View Audit

User Administration

2. Inthe User Detail box that appears, complete all fields:

Field Information required
Username For all new users, make username their first initial and surname in
capitals, e.g. for John Smith set username as JSMITH
First Name/Last Name Enter both first and last name of user
E-mail Enter users work e-mail address
Credentials Provides edit permissions for staff. There are options to choose from:

- Administrator: This will allow staff to add and delete users and
manage supply bookings within a school or cluster. This access
should be give to SSM/SSC’s

- Edit Permissions: This will allow access to create and edit the
supply booking of a teacher only. This access should be given
to admin staff

- View Only Permissions: This allows a view access only to the
booking on the system within their respective school, no edit
function available with this access. This should be given to
Head Teachers/Depute Heads/Principal Teachers

Scope Provides area cover for user. There are 4 options to choose from:

- Cluster: This option is for both School Support Co-ordinators to
give them access to all schools and Managers to give them
access to the administration functions to add new users to their
school

- Finance: For Finance only

- Organisation: This if for HQ Staff only, staff within schools will
not see the scope option

6
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Field

Information required

- School: This option is for admin staff within all schools

Base School

This provide a drop down list of all schools within the Authority and
identifies the schools in which the user is based.

Status

This is the status of that users account. There are 4 options:

- Account Active: Select this when setting up a new user to give
them access to the system

- Account Locked: This takes access away from a user

- Not Active: This takes access away from a user, should be
used for any members of staff that have left the school

- Password Reset Required: If a member of staff needs to reset
their password it can be done through select this option, or
through the Reset Password button on the sign in page

3. Click Create. The user will now appear on the list on the User Administration page. To

make any changes to their account click the yellow pencil ( = ) on the left hand side
against their name to edit.
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Icon What it means
¥ Booked
Teacher Preference
1l
Only this School
Shortlisted
C

Creating a requirement

1. To book a supply teacher, select Shortlisting from the list on the left. This will take you
to the Shortlisting — Main List page where you will be able to see all bookings that have
been made in your school. To create a new booking, click Create.

Home

Administration

Finance Administrati...

Core Tables

Shortlisting

Timesheets

Timesheet Report

W8 Shortlisting - Main List

Q ~ Go Actions v

2. A New Booking Requirement box will appear. Fill out the different fields:

E New Booking Requirement

* School | <Not selected> v * Subject  <Not selected>

<Not Selected> ~

Reason Code

MNotes
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Field Information required

School This will default to school/s according to the
access someone has

Subject Qualified GTC subject, specific to both
secondary and primaries

Reason Code Length of cover required in schools. Enter if
known at point of creating the booking, if it
is not known then can be added later

Notes Free text box

Once you have entered all information, click Create. (Clicking Cancel will take you back to
the main Shortlisting page). You will be taken to the Shortlist page to input hours required a
select a teacher to book.

Choosing hours for a requirement

To input the required days you need a supply teacher for, you can either:

¢ Click Add Day Pattern. This will allow you to add a weekly pattern for as many weeks
as required.

- In the Select Date field chose the first day you need the teacher to cover, and then
type in the number of weeks you will need them for in the Weeks field

- Then select the days you want the teacher to work. If you need a teacher to work for
a whole week then you must tick the box against all five days of the week, where
you can then select if it is AM/PM/AII day. If you only need a teacher to cover some
days of the week then only tick the days you need them for and this will filter
through on the booking based on the number of weeks you have input. Click Save.

WR Day Pattern

Wesk st (Mor)  26/07/2021 Week Enc () 06/08/2021 < E.g. If you need a teacher to cover supply
“SeectDate | 26/0772001 = e o in your school for 2 full weeks, you day
& von aM oM © AllDay pattern will look like this
B ue aM () P € All Day
& wep am (e QAN Day
B AM () PM Q) All Day
I aM (M Q) ANlDay
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E.g. If you need a teacher for 4 weeks on a
Wednesday only, your day pattern will look Day Pattern
like this >
Week start (Mon)  26/07/2021 Week End (Fri)  20/08/2021
* Select Date  26/07/2021 B *Wesks 4
o
TuE
B wo am (e € All Day
THU
[Jeri
o Select each day a teacher is required

for on the calendar. You will be given
the option of the day pattern, once you have selected this click Create.

- July 2021 month | st Wl Add Requirement

Mon Tue Wed Thu Fri
Booking Dat=  13/07/2021

19 20 21 29 23 > Day Part  Whole Day

Status  REQ
26 27 28 29 30

3. Once you have entered the required dates you need covered either using the
requirements calendar or the Add Day Pattern options, you will see on the left hand side
of the screen the list of supply teachers that meet the requirements of your booking
and are available to be booked. You can browse candidates in a number of ways:

- Scroll through the list as it appears

- Search for a particular teacher using the search bar

- To search for teachers by postcode, click Actions > Filter > In the Column Field
select Postcode > In the Operator field select Contains > In the Expression Field
put in a postcode/part of a postcode > Click Apply, e.g. if you only want to consider
teachers in the surrounding area with a G Postcode then enter G in the Expressions
field

- Tofind teacher that are approved to work in Roman Catholic schools, click Actions
> Filter > In the Column Field select RC Approved > In the Operator column select
= > |n the Expression field select Y > Apply. You will then be able to see all RC
approved teachers.

You can view the details of a teacher by clicking the yellow pencil to the left of their name.

4. When you come across some teachers you would like to try booking, you can select

Shortlist ( B ), @ pop up box will ask you to confirm that person for your shortlist,
select Yes. Anyone you shortlist will move in to the Shortlist tab along with all their
contact information to allow you to try getting in touch with them by telephone using the
number provided or by email to see if they can work in your school. Choosing email will
send the following email to teachers on your shortlist:

10
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Request availability for Supply Booking
If contacting the school in relation to this requirement please quote Ref: BR\ED0101001100.

Dear John Smith,

Our records indicate that you may be available to provide tuition in Computing at Bearsden
Academy on the date(s) shown below.

11/08/2021 Whole Day
20/08/2021 Whole Day

If you are available to fill this booking, please contact the school office at:

office@bearsdenacademy.e-dunbarton.sch.uk

You can remove a teacher from your shortlist by clicking the Remove option; this will
return you to the All Teachers Tab.

5. Once you have contacted a teacher and confirmed the booking with them, you can then

click Book (I:| ) to book the teacher on the database. Again a box will pop up asking
you to confirm you want to book that teachers; select Yes. You will now be able to see
the booking on the request calendar and on the Booking Tab.

All Teachers  Shortlisted | Booked [Notes >
Qv Go || Actions™ 4 > August 2021 month list
Remove Name Day tel Mobile Booked Postcode Mon Tue Wed Thu Fri
2 3 4 5 6
l:l Teacher Name  Day no. Mobile no. Pastcade
9 10 11 12 13
16 7 18 19 20
S——
(Whole Day)

Once you have booked a teacher on the system, you can then send a confirmation e-mail
providing information about the booking and a link to the EDC Hub to access the Teacher
Attendance Form and guidance. *Please Note* when calling a supply teacher and
confirming a booking with them, ask them to check their SPAM folder for this email if it does
not arrive right away.

- When on the booked tab, next to the teachers name click the button that says email

- In the box that appears, you will see the e-mail address in the system for that
teacher. If this is correct, click send

- The following e-mail will be sent to the teacher with information about the booking:

Confirmation of Supply Booking

If contacting the school in relation to this booking please quote Ref: BR\ED012\000607.

11



. P\ sustainable thriving achieving
\I;:?;L;ﬁdgtg d: 13/04/22 9 East Dunbartonshire Council

www.eastdunbarton gov.uk

This email is to confirm that John Smith, (employee no - :1234567), has been booked as a supply
teacher at Douglas Academy on the date(s) shown in the table below.

16/08/2021 Whole Day
17/08/2021 Whole Day
18/08/2021 Whole Day

Important points to note:

School holiday dates within booking periods are excluded from payment and should not be
submitted as part of your Teacher Attendance Form.

It is your responsibility to submit a completed Teacher Attendance Form o time to the school office
for processing.

Please complete all sections of the form electronically and email it to the school office at:
office@douglas.e-dunbarton.sch.uk

Forms should be submitted by the last Friday of every month - failure to submit forms on time
could lead to delays in payment.

Guidance on completion of the Teacher Attendance Form together with blank forms can be found
here.

This link can only be accessed from an EDC device. If you cannot access this link please contact the
school office.

Finally, please be aware that your payslip will show the total time worked in hours and not days.

Removing information from a booking

If you need to remove a teacher from a booking, you can either click each day on the
request calendar and select either:

- Delete Booking: This will remove the teacher from that particular day. This could be
because you contact a teacher and there is a day in your requirement that they can
not do, in which case you will need to book another teacher to cover that one day

- Delete Requirement: This will remove that day as a requirement e.g. that day no
longer requires a teacher to provide supply cover on it

You can also delete the whole request by selecting Delete on the right
hand side of the screen to start the requirement again

Delete

Add Day Pattern

month list

Fri

Once you have booked a teacher, you will see that the information at the top of the
booking has updated and the status of the booking has changed from REQ (required)
to BOO (Booked) and that the number of slots they have been booked for has been
filled. Also the start date and end date of the cover is shown. If you know the Reason
code at this stage you can add it at the top and select Apply Changes to save the

12
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3 Shortlist

Ref: BRVAAG99\000310

Empty Slots @

Booked Slots 4

Total Slots 4
Status  BOO

School Name  Kirkintilloch High Subject French

Start Date  27/07/2021

End Date  31/07/2021

Reason Code  <Not selected> v Apply Changes

If you need to make any amendments to a booking, from the Shortlisting — Main List page,
select the yellow pencil next to a booking to do so

Teacher Usage Report

The Teacher Usage report provides a breakdown of supply teacher usage and captures all
supply books completed on the system. It can be accessed from the menu down the left

hand side of the database

Home

Administration W

Finance Administrati... ~

Shortlisting

Timesheets

Timesheet Report

Teacher Usage I

The report allows you to filter on all column headers as required. Further refinement of data
is available by clicking directly on blue highlighted headers

Requirement Ref

Teacher Name T=

e’ = K
Y Go 3. Bookings by Teacher v Actions v

School Name Subject Day Part Sector Emp No Ni No

13
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There are currently four booking reports available:

Report Name Information within report

Primary Report This is the default report and includes all
data for respective school(s). If you have
access to more than one school, you can
filter by individual school

Bookings by school This report filters by school name. If you
have access to more than one school you
can filter by individual school.

To see what teachers you have booked to
work in your schools over a certain period,
filter this report by Date for the date range
you are interested in

Bookings by teacher This report filters by teacher name

Total Bookings per school This provides the total number of bookings
by school. This can be filtered by school
name if you have access to more than one
school

Saving Custom Reports

Using the filtering functions available, you can also create your own custom report to include
only the information you are interested from all that is available. This report can then be
saved and used as and when required. This report will only be unique to your establishment
and will not appear on any other schools page.

Once you have made your report with the filters you want, click Actions > Report > Save
Report. You can then export this report you have made as a CSV, PDF or Email by
selecting Actions > Download

Saving a report Download a report
Actions Actions
M columns [ Columns
Y Filter Y Filter
== Data - B2 Data >
7 ]
‘2'\3 Format » s Format >
Chart I alll Chart
~ - Group By
= Group By = p
— 'F Pivo .
| Pivot T
[l Report >
Report >
:
o, Download E. Recet - 1
— (2) Help

14
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Timesheets

The Timesheets part of this process is to be used for both Supply Teachers and
Permanent Teachers working additional hours, and is split in to two sections:

e Supply teacher/perm additional hours teacher fills in digital timesheet of hours worked
e School create timesheet on database with information for Payroll to pay teacher

Process for Supply Teacher/Permanent Teacher working additional Hours

When a supply teacher is booked on the database, they will receive a confirmation e-mail
with a link to the East Dunbartonshire Council website, where they will see Teacher
Attendance Form (This can be found within Employee Zone > Policy & Procedures). If
there is a Permanent Teacher working additional hours, they do not need to be booked out
on the system, therefore they will need to have the link to this page sent to them via e-mail.

For school office info, the forms can be found on the EDC Website and the Hub at the links
below:

¢ [East Dunbartonshire Website
¢ Education Processes (SEEMiS Replacement) on the Hub

The teacher must complete the timesheet below electronically, filling in the dates and hours
they have worked in one school. Once they have signed and dated the timesheet, they
should then e-mail the completed time sheet to the school office. In order to be paid on
time, the teacher must submit the timesheet by last Friday of every month.

Please Note:

e This time sheet must be completed electronically and then e-mailed to the school
office. A physical copy should not be printed and filled in.

e The booking confirmation e-mail contains information the teacher needs to complete
the time sheet, ie. their employee number, school office e-mail address

o ltis the Teachers responsibility to ensure that their time sheet is completed correctly
and submitted on time. Failure to do this could lead to delays and Payroll processing
could carry forward to the following month. Direct the teacher to the information box
on the timesheet for information about this

o If ateacher has worked in more than one school in the one pay period, they must
complete a separate sheet for each school

Inputting timesheet information on the database

The information on the teachers digital timesheet return must be entering in to the Supply
Teacher Database in order to be processed by payroll and the teacher paid.

15
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Once a teacher has emailed their digital timesheet to the school office where they

have worked, an admin member will need to complete the sections marked OFFICE
ONLY on the sheet and save the complete timesheet in an appropriate place for your
schools own audit purposes

Section of timesheet

Data required

Booking Type

:| OFFICE OMLY [~

'

FIXED TERM

SUPPLY
) ]

For each date that has hours worked
against it, select the Booking type from the
list provided

Supply = less than 2 days

Fixed Term = more than 2 days

OFFICE OMLY
For Permanent teachers doing additional
hours leave this blank
Reason For each date that has hours worked
Code against it, select the correct Reason Code
LE_I{}FH{:E ONLY |~ for each day from the list provided. If you do
OFFICE ONLY not know the reason code, contact your
OFFICE ONLY SSC/SSM and they can provide this
OFFICE ONLY information
OFFICE OMLY
Days Worked: Full Sheet Total Sick Absence
Whole Days Hours Whole Days Hours
Enter Tota Enter Tota Enter Tota Enter Total number
number of days number of number of days | of hours sick
worked hours worked sick

Supply Teachers will add up the total number of days and hours they have worked, as well
as total number of days/hours they have been off sick. Please check that the totals they
have entered are correct and amend if necessary.

If a teacher has ticked any date to say they were sick, then also add this information up
and put the total in days and hours in the Sick Absence section, and follow the current
process that is in place for paying supply teacher who have been off and are entitled to
sick pay

2. Once you have filled in the OFFICE ONLY sections of the timesheet, Save the

timesheet in an appropriate place. Now the information on the timesheet can be input
in to the database

16
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3. Within the database, along the left hand side select Timesheets and then select
Create to make a new one.

TOTTTE

Administration

Finance Administrati... ~

Core Tables

Shortlisting

Timesheets

Timesheet Report

Timesheets - Main List

Qv Go Actions ™

‘ Create Timesheet

4. A Create Timesheet box will .

appear; fill in all fields:

* Start Date (1st = * School  Bishapbriggs Academy

Field

Data Required

Start Date (15t Monday)

Select the first Monday for the week the teacher started
working in your school e.g. if a teacher did Wednesday 21t —
Friday 23 in a school, select the date Monday 19

School This will auto-populate with your school and cannot be
changed
(those with Cluster permissions will be able to select from the
schools in their Cluster)

Teacher Select the name of the teacher who has submitted the

timesheet, confirming the employee number on the database
matches the one on the sheet (Use employees numbers to
differentiate between teachers with the same name)

Date Submitted

Auto-populates to date timesheet is created

Reason Code

Enter Reason code, contact your SSC/SSM if unknown

Contract Type

Distinguishes between teachers who have worked supply and
those who are permanent teachers working additional hours.
Select the correct option based off the information the teacher
has put on their sheet and the time they have worked

17
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TS Ref  TS\EDO14\001147 Timeshest IN PROGRESS Contract Type
Status

Mame  Colin McCulloch School  Kirkintilloch High Reason Cade

Address Employee 1234567 Scheol
Number

NiNe MNH565656A

Cancel Delete Apply Changes

Supply Teacher - (fixed tt v Signed by =

Teacher

(25) Foreseen Long Term v Paszedto  14/10/2021 2=
Office

<Not Specified> v

HT Approval =

Telephone No

Sent Payroll

5. When the timesheet has been created, you will be taken to the Timesheet Entry
Form. Here, you will see at a glance some contact information about the teacher

along with some editable fields.

Field

Data Required

Contract Type

Pre-populated with type selected when
creating timesheet. Can be changed
between:

e Permanent Staff
e Supply Teacher (< 2 days)
e Supply Teacher (fixed term)

Reason Code

Pre-populated with Reason Code selected
when creating timesheet

School

This field is only to be filled in if the
timesheet is for a Permanent Teacher
working additional hours. Choose the name
of the school they have a permanent
contract at from the list

Passed to Office

Auto-populates to the date that the
timesheet was created

Signed by Teacher

This is the date that the teacher has e-
mailed timesheet to school office. Only
saved to record when Apply Changes is
clicked

Processed by SSC/SSM/Admin

The field will auto-populate when Awaiting
Approval button is pressed to change
status of timesheet to Awaiting Approval

Approved by Head Teacher

Once the Head Teacher has approved the
timesheets via the Head Teacher Summary
report, this field will auto-populate when
Complete button is pressed to change the
status of timesheet to Complete

Sent to Payroll

Auto-populate when timesheet status is
changed from Complete to Sent to Payroll
on the Timesheet Main List page
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Status of Timesheets - Overview

There are a number of different statuses that timesheets can be on the database which
relate to various stages of the process. What you are able to do on a timesheet when it is at
each status is unique also.

Status

In Progress

Description of Status

Status that record is automatically set to when timesheet is
created on system.

Functions available:

Input hours against days worked by teacher
Input/edit reason codes against days worked
- Add a note to record

Delete record

Final stage of status: SSC/SSM to check details on timesheet
records are correct, Once checked, all records to be changed to

Awaiting Approval by selecting

Access

Everyone

Awaiting Approval

Selecting Request Approval button on timesheet record sets this
status and populates SSC/SSM/Adm date field. Head Teacher
Report will run off records sitting at this status. Report must be
downloaded from system and e-mail to Head Teacher for
approval, with SSM/SSC cc’d.

Functions available:

Input hours against days worked by teacher
Input/edit reason codes against days worked
- Add a note to record

Delete record

Final stage of status: Head Teacher gives approval for all records
sitting on system via e-mail. All records to be changed to

Everyone

Complete

Selecting Complete Timesheet button on timesheet record sets
this status and populates HT Approval date field. Records are
locked at this status and no changes can be made without
unlocking first. Payroll Report will run off records sitting at this
status. Report must be downloaded from system and e-mailed to
Payroll within same e-mail chain as Head Teachers Approval, with
SSC/SSM cc'd.

Functions available:

- Unlock timesheet to revert back to /n Progress if error
noticed on record before sending Payroll Report

SSC/SSM
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- Add a note

Final stage of status: Payroll Report emailed to Payroll for
processing. Do not make any more changes to records/statuses
on the system until Finance contact to advise differently

Sent To Payroll

Selecting Send to Payroll button when using the add bulk feature
changes records sitting at Complete to this status and populates
Sent Payroll date field. This should only be done once Finance
contact schools to advise that recharge has been complete.

Functions available:
- Add a note

Once record is sitting at this status, it can not be unlocked to be
amended, or deleted. If no errors have been identified during
processing, then changing records to this status is the final step in
the process and prevents old records already submitted to Payroll
pulling through on to future reports.

No users

Void

The VOID status should only be used if an overpayment error
has been identified and the Payroll Report has been submitted
but Payroll processing is hot complete.

The entire timesheet for the employee in question must be
marked as void — please refer to Timesheets - Guidance on
Correcting Entries on the Hub.

Only records with status Complete can be changed to Void by

selecting . Once at this status, it cannot be

unlocked to be amended, or deleted.

Functions available:
- Add a note

A note must be added to Void Records with information on the
error identified and wat mitigating action is being taken (a note
must also be added to the new record that is create to correct the
identified error)

Note: Do not VOID a timesheet if the Payroll processing has
been complete — please refer to Timesheets - Guidance on
Correcting Entries on the Hub and refer to your SSC / SSM

SSC/SSM
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Entering hours worked on to a timesheet

At the bottom of the page there is a long list of dates Mon-Fri. This is 5 weeks from the start
date (1%t Monday) that was chosen when the timesheet was created as there are 5 weeks
worth of hours a teacher can work in a pay period. Please note that only days that have
Hours entered against them will pull through to the report for Payroll so teachers will only be
paid for day that have hours entered against them.

Click on the yellow pencil against a day the teacher has worked, and in the Timesheet
Details box that appears, fill in the following fields:

e Hrs: The hours the teacher has worked on that particular day according to their
timesheet.

e Sick: Select Yes/No from the drop down if the teacher’s digital timesheet reports them
as sick for that day

¢ Reason Code: This can be changed here if a particular day a teacher has worked was
under a different reason code. Your SSC/SSM will tell you if this is the case.

o Contract Type: Select if the teacher worked that day as supply or permanent doing
additional hours

*PLEASE NOTE" If a teacher in your school works under a different reason code in the
morning and the afternoon, then you must create two timesheets — one with morning
hours, and one with afternoon hours.

Stats

On the Stats Tab ( ), you will be able to see some more information:

- Start and end date of the pay period

- Total number of days and hours entered on the sheet

- The estimated cost of the booking (£270 is the average daily rate in the system for
the cost of a supply teacher for one day, therefore 270 x no. of hours worked =
estimated total for teacher)

Start Date  06/09/2021 End Date  08/10/2021
Days Claimed 23 Hrs Claimed 150 Est Cost  £5785.71
Motes
On the Notes Tab ( ), you will be able to add notes to a timesheet record, no

matter the status of the timesheet.

Adding hours onto a timesheet in bulk

If a teacher has worked for whole weeks at a time for a few weeks with the same reason
code, e.g. a teacher has worked for 3 weeks, 7 hours each day, under reason code 24 (Long
Term Absence over 9 days), you are able to load that information in to the system in one go.
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Add Bulk
1. Click Add Bulk on the right hand side of the screen

2. In the pop-up box that appears, enter the first date that the teacher has entered on
their time sheet in the Start Date field and the last date on their time sheet in the End
Date field.

Then, select the Reason Code for all of those days, as well as the contract type for
the teacher. The hours are set to 7 automatically, so please change this if required,
then select Apply. You will then see that all the available dates between the start and
end date you entered will have the hour worked, contract type and reason code
against them.

3. If you have entered hours against a day and need to remove them, click the yellow

pencil and then just remove the number of hours that was entered and click Apply
Changes, then you will see that day no longer has hours against it.

Entering hours worked on an In-service day/Holiday

A school calendar held within the background of system prevents the input of hours on days
which are Holidays (non-working schools days). Any day that is a school holiday where
teachers would not work will have the symbol below next to it, as well as information in the
Holiday Description column of a timesheet record.

In-service days are also recorded in the system. These days will have the green symbol
below, next to them, as well as In-Service Day in the Holiday Description column of a
timesheet record. When adding hours In Bulk, any in-service days worked in the date range
you select will not pull through as hours worked at the bottom of the page.

As some teachers do work on In-service days, Schools can manually enter hours worked
on that day using the yellow pencil.

n

Requesting Approval

Once you have input all information from the teachers’ digital timesheet in to the database
and have checked all information is correct, please contact your SSM/SSC to let them
know that the entry is ready for them to review.

Once the SSC/SSM has confirmed timesheets are ready to be approved by Head Teacher,

click Request Approval to change timesheet status to Awaiting Approval. This will auto-
populate the Processed by SSC/SSM/Admin field with the date. This can be done
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individually or using the Bulk function (steps to do this are on page 23)

> Timesheet Status  AWAITING APPROVAL

Timesheet Report

Timesheet Reports have been created to provide information from the system relating to
hours teachers have worked. These reports can be sent to Head Teachers to approve
timesheet and Payroll to process timesheets. The reports must be approved by the Head
Teacher before sending to Payroll for processing.

Please note - there may be changes made to values or codes within the background of the
system over time, e.g. the average daily cost for a supply teacher is reviewed each year and
therefore could change or reason codes could be amended. Be aware - when these values
are changed, they impact the new records added in the future, but also all historical records
sitting in the system. Therefore, for Schools to review historical information, please rely on
days / hours worked and not cost OR refer to the reports downloaded and saved direct from
the system at the time of processing.

When running reports from the Supply Teacher Database, please ensure that the

appropriate filters are on each report so only the required information pulls through. If
filters are missing from report, close down the database and re-open to reset.

Head Teacher Summary — the correct filters are:

~ Status = 'AWAITING APPROVAL

v’ Teacher Mame

Payroll Report - the correct filters are:

Status = 'COMPLETE

Teacher Mame

Report Name Description of Report STATUS report

pulls from
Primary Report This report contains all information relating | Does not pull
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Report Name Description of Report STATUS report

pulls from
to timesheets for your school on the on a status
system. It can be filtered in any way you
need to provide information about your
records for your school using the Filter
option. It is also possible to create custom
reports with this information.

Head Teacher Summary | Provides high level information for Head AWAITING
Teachers about total number of hours a APPROVAL
teacher has worked in their school and the
estimated cost. Report only pulls
through timesheets marked as Awaiting
Approval. Timesheets with the status
In Progress or Complete will NOT be
included within this report.

Payroll Report Provides detailed information about the COMPLETE
hours a teacher has worked in school
which Payroll require to process a
timesheet. Report filtered to only pull
through timesheets marked as Complete.
Timesheets with the status In Progress
or Awaiting Approval will NOT be
included within this report.

This report can also be provided to Head
Teachers / SSM / SSCs if a more
breakdown of the Head Teacher Summary
is required / preferred.

Void Report Provides detail on records that have been | VOID
marked as VOID on the system, following
identification of an error to a record during
Payroll Processing. Can be filtered by date
if required

How to create Custom Reports

The database allows you to create your own custom reports from any of the different pieces
of information held within the system using the Primary Report. This may be useful to help
you to identify amounts spent on Individual / Groups of teachers or Individual / Groups of
Reason Codes, or provide specific information requested by your Head Teacher.

The Reports can be downloaded into Excel and then filtered and sorted for whatever
information you are required to check.

1. On the Timesheet Report section of the system, select 1. Primary Report from the
drop down lists of reports available

2. Click Action > Columns. This will show you all the different pieces of information
you can make a report on
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3. Using the buttons down the middle of the columns, move information you need in to
the Display In Report column, and any information you do not need in the Do not

display column.

4. Once you have all the columns you require, click Apply

5. To save this report and rename, select Actions > Report > Save Report, then name

your report

6. Your custom report will show under Private from the drop down list of reports and

can be ran any time.

1. Test Report

1

2
3
4
3
6

Default

. Primary Report

. Budget Report

. Head Teacher Summary
. High Level Payrol

. Payroll Report

. Total Hrs Claimed by School

. VOID Report

Private

1. Test Report

7. To delete a customer report, delete the filter showing on the report and select Apply
to the message that appears

Saved Report =

"“Test Report”

O

To obtain Head Teacher approval:

1.

2. From the drop down list, select Head Teacher Summary

Once the SSM/SSC has reviewed all timesheets and all

records have had their status changed to Awaiting

Approval, the report is ready to be run. Select Timesheet

Report from the menu on the left hand side

25

Home

Administration ™
Finance Administrati... »
Core Tables v
Shortlisting

Timesheets

Timesheet Report




. P sustainable thriving achieving
\I_Iz?; |L(;Ir::dgtg d: 13104122 9 East Dunbartonshire Council

www.eastdunbarton gov.uk

3. Head Teacher Surnmary g

Default
1. Primary Report
2. Budget Report
4. High Level Payrol
5. Payrell Report
6. Total Hrs Claimed by Schoo

3. Ensure the following filters appear on the report (if they do not, add filter back on or
close down system and re-open to regenerate filters):

a ﬂ Status = 'AWAITING APPROVAL
w = Teacher Mame

This report will only show timesheets that have been marked as Awaiting Approval so you
must ensure all timesheets requiring Head Teacher approval has been changed to status,
Awaiting Approval.

The information on the Head Teacher Summary is identicial to that of the Payroll report; the
only difference between the two is what status it pulls from.

School Hrs Est TS Submit Approved
Name Date Emp No Ni No Claimed Cost{f) Reason Budget Supply Type Date HT Sick  Status

4. To run the report to send to your Head Teacher, click on Actions > Download. In the
pop up box that appears select CSV. Save this document in an appropriate place and
then e-mail to your Head Teacher to approve the reports. Their e-mail signature is
sufficient for the timesheets to be actioned by Payroll.

It is vital that Head Teachers are familiar with the Head Teacher Report and understand the
requirements as the budget holder, to thoroughly check timesheet submissions each month,
as this is key to identifying any anomalies and preventing errors before the Payroll
processing takes place.

When reviewing the report each month, Head Teacher should:

¢ examine every entry within the report prior to approving to ensure the details are
correct

e ensure employees included in the report have undertaken Supply or additional
hours, within your own School, on the dates specified

e ensure hours included in the report are accurate and in line with Supply or
additional hours worked, on the dates specified

e query any estimated costs that don’t look quite right, with your SSC / SSM

e query any suspected anomalies in the report with your SSC / SSM and ensure the
data within the report is correct before providing approval to progress to Payroll.
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Head Teachers support in checking the report, prior to providing approval, will help to
identify any incorrect salary payments, allows for errors to be rectified before these are
processed by the Payroll Team and removes the need for time consuming investigations
when errors are identified too late.

Once Head Teacher approval has been provided via e-mail, the status of each timesheet
must be changed from Awaiting Approval to Complete. This can be done individually or
using the Bulk function (steps to do this are on page 28)

‘ > Timesheet COMPLETE
Status

Unlocking timesheets

Once a timesheet has been marked as Complete, it is then locked and no more changes
can be made to the timesheet and it cannot be deleted. If an error has been made on a
timesheet that is locked after it has been approved by the Head Teacher, please refer to
Timesheets - Guidance on Correcting Entries on the Hub and refer to your SSC / SSM.

Sending Reports for Payroll Processing

Once all timesheets for the current pay period have had their status changed to Complete,
the information must then be sent to Payroll for processing.

1. Go to the Timesheet Report section of the system, from the dropdown select Payroll
Report and ensure the following filters appear (if they do not, add filter back on or
close down system and re-open to regenerate filters):

v Status = 'COMPLETE

e = Teacher Mame

2. Download CSV. Open the report and check that all information has pulled through
and is correct. Then save this document for your own audit records

3. Attach the downloaded Payroll Report to the Head Teacher approval email and
send to Payroll for processing. Existing Payroll cut-off dates still apply.

For Audit purposes, Payroll must receive the Payroll report and the Head Teacher’s
approval email.

Once a timesheet has been marked as Complete, you cannot delete or amend the
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timesheet. If you realise there is an error on the timesheet after you have locked it and
before a report has gone to Payroll, you will need to contact your School support Co-
ordinator or Manager who have the ability to do this.

If a changes needs to be made to a timesheet after the report has been submitted to Payroll,
you must request a Journal.

How to update status in Bulk

The status of timesheets can be changed in bulk, without needing to go in and out of each
individual record. This feature can help save time and make the process easier if you have
multiple timesheets in the system. Statuses can only be moved in the following order; you
cannot skip over a step using this function:

In Progress > Awaiting Approval
Awaiting Approval > Complete
Complete > Sent To Payroll

To change the status of records in bulk:

1. Go to the Timesheet — Main List page O

Select

2. Here you will be able to see all records for timesheets in A fimesheet it
your system. Down the left hand side of the screen, you 7 SEDO1£001145
will see a tick box next to each record. Tick this box next
to each record whose status you would like to change 7 EDOI£001 144

O TS\EDO144001143

3. (To use the Select all Feature which ticks all records on the screen, you can filter on
the current status of the timesheets. E.g. If you are wanting to close down processed
timesheets, filter the status on Complete)

*Please note* If the ‘Select All’ box does not tick all records on first try, please refresh
the page and try again.

ol Status = '"COMPLETE
Select Teacher School Start Date Submitted
All Timesheet Ref Name Name End Date Date Status
TS\EDO141001150 2 _'Tu loch :f'.':'ﬂ”t" och 11/10/2021  12/11/2021  14/10/2021  COMPLETE
TS\EDO141001148 _'Tu loch :f'.':'ﬂ”t" och 04/10/2021  05/11/2021  14/10/2021  COMPLETE
TS\EDO14,001149 ff_'ﬂ‘u . }:'.':'a”t" och 04/10/2021  05/11/2021  14/10/2021  COMPLETE

4. Once you have selected all of the records you need to change, select the status you
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want to change the records too using the three options from the top right hand
corner of the screen

m Request Approval Complete Timesheet Send to Payroll

5. A box will appear for you to confirm the date that these records are being changed.
This date will pull through on to each timesheet record. The field will default to
today’s date however you can enter a date in the past, then click OK

(e.g. if your SSC/SSM told you that your records were ready to go to the Head
Teacher on the Friday but you are not changing the status until Monday, you can
enter Friday’s Date when clicking Awaiting Approval)

6. You will see from the Main list that the status for the selected records will have
changed

Changing records from Complete to Sent to Payroll - for clear down ahead
of the next payrun

Once the Payroll report has been sent to and processed by Payroll, those records need to
be closed down on the database so that they do not pull through on future Payroll Reports
and lead to duplicate payments.

This task should not be done on the system until Finance Team have issued the
finance journal for recharge for the current month’s PYOL'’s. Once you have heard from
the Finance team with this information, records from the previous pay run should be
changed to Sent to Payroll BEFORE any new timesheets for the next pay run as put on to
the system.

To do this, the status of the timesheets that have been sent for processing need to be
changed from Complete to Sent To Payroll. This must be done using the Update in Bulk
function:

*PLEASE NOTE* Once a record has been marked as Sent to Payroll it cannot be
unlocked or changed. If an error is found then contact your SSC/SSM and raise a
Journal if need be.

To change the status:

1. On the Timesheet — Main List page, select the check box for all records sitting at
Complete, or filter the page to show only Complete records

2. Double check that you have selected all the correct records against the Payroll
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Report
3. Click Sent To Payroll from the top right hand corner
4. Check the correct date is showing in the box that appears, then click OK

5. You will see that the status of all record selected is now Sent to Payroll. These
records will not pull through on to any reports for the next pay period

Errors with timesheets after submission to Payroll

If an error is identified with a timesheet record any time after the Payroll Report has been
sent to Payroll, action will need to be taken to rectify this and changes made on the
database.

Depending on the type of error and at what stage in the process it is identified will dictate the
appropriate action required. Please refer to Timesheets - Guidance on Correcting Entries on
the Hub and refer to your SSC / SSM.

Void Status

The Void Status should ONLY be used when:
1. The timesheet record has a COMPLETE status and
2. an overpayment error has been identified and
3. the Payroll Report has been submitted but Payroll processing is not complete.

Refer to Timesheets - Guidance on Correcting Entries and refer to your SSC / SSM

If these conditions are all met, the incorrect timesheet should be marked as Void on the
system and a new correct timesheet should be created which needs to be approved by the
Head Teacher and sent to Payroll.

Only SSC/SSM’s can mark timesheet records as VOID

To Void a timesheet, select the button on a record sitting at Complete.

This will change the status to VOID. Ensure that a note is added to the Void record to
provide information about the action that is being taken to resolve the issue.

Once you have created a new timesheet which corrects the error made in the original
Payroll Report and have followed the whole approval process up until the timesheet is sitting
at Complete, you will need to run a new Payroll Report only containing the new record. To
do this:

1. On Timesheet Report section of the system, select 5. Payroll Report from the drop

down list
2. Check that the following filters are on the report:
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" Teacher Mame

z ﬂ Status = 'COMPLETE

3. In the search bar, type in the teachers name who the new record has been made for

4. Ensure that only the information relating to the correct record is showing, before
selecting Action > Download > CSV

5. Check again that the report only has information about the corrected entry, then send
the report via e-mail to Payroll (with HT Approval within e-mail chain), making
mention that this is a new record that is correcting one with an error
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	Timesheet Report


	 
	 How to create custom reports


	 How to create custom reports


	 How to create custom reports



	 Head Teacher Approval


	 Head Teacher Approval



	 Unlocking timesheets


	 Unlocking timesheets



	 Sending reports for Payroll processing


	 Sending reports for Payroll processing



	 How to update status in bulk


	 How to update status in bulk



	 Sent to Payroll - Clearing down processed records ahead of the next pay run


	 Sent to Payroll - Clearing down processed records ahead of the next pay run



	 Errors with timesheets after submission to Payroll


	 Errors with timesheets after submission to Payroll



	 Void Status
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	Introduction

 
	 
	This guide will provide information on how to use the Supply Teacher Booking Database

which is used to book out and create timesheets for Supply Teachers working in EDC

schools, as well as timesheets for any permanent teachers who work additional hours.


	 
	High level steps within booking & timesheets processes:


	 
	 
	 
	InlineShape

	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	How to access the database

 
	 
	To access the database, you will first need to connect to a RDP Server.


	 
	 
	 
	Logging in to the RDP Server
	Logging in to the RDP Server
	Figure

	 
	This requires you to log in to an application on your computer before logging in to the

database. IT will have set this up for you and created a shortcut on your desktop in which to

access the server. *Please note: New members of staff will need to contact IT Service

desk to be given access to the server*


	 
	 
	Figure
	1. Click on the shortcut EDU-FMS-RDS (it may also be called FMS

Remote Desktop and can be found in your Staff folder)


	 
	 
	 
	 
	 
	2. On the log in screen that appears, enter your user name and password. The password

should be the same one you use to log in to your computer, and so should your

username except with the characters sch\ before it, demonstrated in the picture below.


	 
	 
	Figure
	 
	To log in to a different account, select More

Choices > Use a different account.


	 
	 
	 
	 
	 
	 
	 
	 
	 
	Figure
	Once you are logged in to the RDP Server, you will then be able to access

the database via the shortcut on your desktop


	 
	 
	 
	 
	 
	*PLEASE NOTE* When you have finished in the RDP Server, you must

ensure you log out of the server by clicking the red LOG OFF icon.
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	Logging in to the database for the first time
	Logging in to the database for the first time
	Figure

	 
	 
	A username will have already been set up for you to

use the database, however when logging in for the first

time you will need to set your own password.


	 
	1. On the log in page, click Reset Password


	1. On the log in page, click Reset Password


	1. On the log in page, click Reset Password
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	On the next page there are three steps you need to follow:


	 
	 
	 
	Figure
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	The username that has been set up for you should be your first initial and surname in

capitals e.g. JSMITH, check with your SSC/SSM to confirm. Enter this in to the

Username field then click Request Code, then go and check your e-mail inbox.


	 
	 
	Figure
	 
	 
	 
	You will receive an e-mail from a

do_not_reply address providing you with a

code made up of both upper and lower case

letters. Copy the code exactly and paste it in

to the Enter code here field, then click

Submit Code. If you do not receive a code

then please contact your SSM/SSC as your

e-mail address may have been entered

incorrectly when setting up your access.


	Figure
	 
	 
	 
	Figure
	 
	Once the code has been submitted successfully, you will then be asked to set your new

password; once you have done this click Reset Password.


	 
	 
	How to reset your password
	How to reset your password
	Figure

	 
	If you have forgotten your password and need to reset it, please follow the same process as

above to create a new one, however do not log out of the database as you will have to

reset the password again


	 
	You can now return to the database log in page and using your username and new

password can now gain access to your account, where you will be taken to the Home Page

of the Supply Teacher Database.
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	Administration Functions

 
	 
	School Support Managers and Co-ordinators will have Administration access which will allow

them to add a new user.


	 
	 
	How to add a new user
	How to add a new user
	Figure

	 
	1. To create profiles for staff members, click on the down arrow next to Administration on

the left hand side of the screen, then click User Administration from the menu that

appears. Once on the User Administration page click Add User.


	1. To create profiles for staff members, click on the down arrow next to Administration on

the left hand side of the screen, then click User Administration from the menu that

appears. Once on the User Administration page click Add User.


	1. To create profiles for staff members, click on the down arrow next to Administration on

the left hand side of the screen, then click User Administration from the menu that

appears. Once on the User Administration page click Add User.
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	2. In the User Detail box that appears, complete all fields:


	2. In the User Detail box that appears, complete all fields:


	2. In the User Detail box that appears, complete all fields:
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	TR
	Span
	Username 
	Username 

	For all new users, make username their first initial and surname in

capitals, e.g. for John Smith set username as JSMITH


	For all new users, make username their first initial and surname in

capitals, e.g. for John Smith set username as JSMITH




	TR
	Span
	First Name/Last Name 
	First Name/Last Name 

	Enter both first and last name of user


	Enter both first and last name of user




	TR
	Span
	E-mail 
	E-mail 

	Enter users work e-mail address


	Enter users work e-mail address




	TR
	Span
	Credentials 
	Credentials 

	Provides edit permissions for staff. There are options to choose from:


	Provides edit permissions for staff. There are options to choose from:


	 
	- Administrator: This will allow staff to add and delete users and

manage supply bookings within a school or cluster. This access

should be give to SSM/SSC’s


	- Administrator: This will allow staff to add and delete users and

manage supply bookings within a school or cluster. This access

should be give to SSM/SSC’s


	- Administrator: This will allow staff to add and delete users and

manage supply bookings within a school or cluster. This access

should be give to SSM/SSC’s




	 
	- Edit Permissions: This will allow access to create and edit the

supply booking of a teacher only. This access should be given

to admin staff


	- Edit Permissions: This will allow access to create and edit the

supply booking of a teacher only. This access should be given

to admin staff


	- Edit Permissions: This will allow access to create and edit the

supply booking of a teacher only. This access should be given

to admin staff




	 
	- View Only Permissions: This allows a view access only to the

booking on the system within their respective school, no edit

function available with this access. This should be given to

Head Teachers/Depute Heads/Principal Teachers


	- View Only Permissions: This allows a view access only to the

booking on the system within their respective school, no edit

function available with this access. This should be given to

Head Teachers/Depute Heads/Principal Teachers


	- View Only Permissions: This allows a view access only to the

booking on the system within their respective school, no edit

function available with this access. This should be given to

Head Teachers/Depute Heads/Principal Teachers
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	Span
	Scope 
	Scope 

	Provides area cover for user. There are 4 options to choose from:


	Provides area cover for user. There are 4 options to choose from:


	 
	- Cluster: This option is for both School Support Co-ordinators to

give them access to all schools and Managers to give them

access to the administration functions to add new users to their

school


	- Cluster: This option is for both School Support Co-ordinators to

give them access to all schools and Managers to give them

access to the administration functions to add new users to their

school


	- Cluster: This option is for both School Support Co-ordinators to

give them access to all schools and Managers to give them

access to the administration functions to add new users to their

school




	 
	- Finance: For Finance only


	- Finance: For Finance only


	- Finance: For Finance only




	 
	- Organisation: This if for HQ Staff only, staff within schools will

not see the scope option


	- Organisation: This if for HQ Staff only, staff within schools will

not see the scope option


	- Organisation: This if for HQ Staff only, staff within schools will

not see the scope option








	Table
	TBody
	TR
	Span
	TH
	Span
	Field  

	TH
	Span
	Information required

 


	TR
	TD
	Span
	 
	 
	- School: This option is for admin staff within all schools


	- School: This option is for admin staff within all schools


	- School: This option is for admin staff within all schools






	TR
	Span
	Base School 
	Base School 

	This provide a drop down list of all schools within the Authority and

identifies the schools in which the user is based.


	This provide a drop down list of all schools within the Authority and

identifies the schools in which the user is based.
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	Status 
	Status 

	This is the status of that users account. There are 4 options:


	This is the status of that users account. There are 4 options:


	 
	- Account Active: Select this when setting up a new user to give

them access to the system


	- Account Active: Select this when setting up a new user to give

them access to the system


	- Account Active: Select this when setting up a new user to give

them access to the system




	 
	- Account Locked: This takes access away from a user


	- Account Locked: This takes access away from a user


	- Account Locked: This takes access away from a user




	 
	- Not Active: This takes access away from a user, should be

used for any members of staff that have left the school


	- Not Active: This takes access away from a user, should be

used for any members of staff that have left the school


	- Not Active: This takes access away from a user, should be

used for any members of staff that have left the school




	 
	- Password Reset Required: If a member of staff needs to reset

their password it can be done through select this option, or

through the Reset Password button on the sign in page


	- Password Reset Required: If a member of staff needs to reset

their password it can be done through select this option, or

through the Reset Password button on the sign in page


	- Password Reset Required: If a member of staff needs to reset

their password it can be done through select this option, or

through the Reset Password button on the sign in page








	 
	3. Click Create. The user will now appear on the list on the User Administration page. To

make any changes to their account click the yellow pencil ( ) on the left hand side

against their name to edit.
	3. Click Create. The user will now appear on the list on the User Administration page. To

make any changes to their account click the yellow pencil ( ) on the left hand side

against their name to edit.
	3. Click Create. The user will now appear on the list on the User Administration page. To

make any changes to their account click the yellow pencil ( ) on the left hand side

against their name to edit.
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	Process for booking a Supply Teacher
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	Booked


	Booked
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	Teacher Preference


	Teacher Preference
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	Only this School


	Only this School
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	Shortlisted


	Shortlisted






	 
	 
	 
	Creating a requirement
	Creating a requirement
	Figure

	 
	1. To book a supply teacher, select Shortlisting from the list on the left. This will take you

to the Shortlisting – Main List page where you will be able to see all bookings that have

been made in your school. To create a new booking, click Create.


	1. To book a supply teacher, select Shortlisting from the list on the left. This will take you

to the Shortlisting – Main List page where you will be able to see all bookings that have

been made in your school. To create a new booking, click Create.


	1. To book a supply teacher, select Shortlisting from the list on the left. This will take you

to the Shortlisting – Main List page where you will be able to see all bookings that have

been made in your school. To create a new booking, click Create.
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	2. A New Booking Requirement box will appear. Fill out the different fields:


	2. A New Booking Requirement box will appear. Fill out the different fields:


	2. A New Booking Requirement box will appear. Fill out the different fields:
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	TR
	Span
	School 
	School 

	This will default to school/s according to the

access someone has


	This will default to school/s according to the

access someone has




	TR
	Span
	Subject 
	Subject 

	Qualified GTC subject, specific to both

secondary and primaries


	Qualified GTC subject, specific to both

secondary and primaries




	TR
	Span
	Reason Code 
	Reason Code 

	Length of cover required in schools. Enter if

known at point of creating the booking, if it

is not known then can be added later


	Length of cover required in schools. Enter if

known at point of creating the booking, if it

is not known then can be added later
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	Notes 
	Notes 

	Free text box


	Free text box






	 
	Once you have entered all information, click Create. (Clicking Cancel will take you back to

the main Shortlisting page). You will be taken to the Shortlist page to input hours required a

select a teacher to book.


	 
	 
	Choosing hours for a requirement
	Choosing hours for a requirement
	Figure

	 
	To input the required days you need a supply teacher for, you can either:


	 
	 Click Add Day Pattern. This will allow you to add a weekly pattern for as many weeks

as required.


	 Click Add Day Pattern. This will allow you to add a weekly pattern for as many weeks

as required.


	 Click Add Day Pattern. This will allow you to add a weekly pattern for as many weeks

as required.




	 
	- In the Select Date field chose the first day you need the teacher to cover, and then

type in the number of weeks you will need them for in the Weeks field


	- In the Select Date field chose the first day you need the teacher to cover, and then

type in the number of weeks you will need them for in the Weeks field


	- In the Select Date field chose the first day you need the teacher to cover, and then

type in the number of weeks you will need them for in the Weeks field



	- Then select the days you want the teacher to work. If you need a teacher to work for

a whole week then you must tick the box against all five days of the week, where

you can then select if it is AM/PM/All day. If you only need a teacher to cover some

days of the week then only tick the days you need them for and this will filter

through on the booking based on the number of weeks you have input. Click Save.


	- Then select the days you want the teacher to work. If you need a teacher to work for

a whole week then you must tick the box against all five days of the week, where

you can then select if it is AM/PM/All day. If you only need a teacher to cover some

days of the week then only tick the days you need them for and this will filter

through on the booking based on the number of weeks you have input. Click Save.
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	< E.g. If you need a teacher to cover supply

in your school for 2 full weeks, you day

pattern will look like this


	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	 
	E.g. If you need a teacher for 4 weeks on a

Wednesday only, your day pattern will look

like this >
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	 Select each day a teacher is required

for on the calendar. You will be given


	 Select each day a teacher is required

for on the calendar. You will be given


	 Select each day a teacher is required

for on the calendar. You will be given



	the option of the day pattern, once you have selected this click Create.


	the option of the day pattern, once you have selected this click Create.
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	3. Once you have entered the required dates you need covered either using the

requirements calendar or the Add Day Pattern options, you will see on the left hand side

of the screen the list of supply teachers that meet the requirements of your booking

and are available to be booked. You can browse candidates in a number of ways:


	3. Once you have entered the required dates you need covered either using the

requirements calendar or the Add Day Pattern options, you will see on the left hand side

of the screen the list of supply teachers that meet the requirements of your booking

and are available to be booked. You can browse candidates in a number of ways:


	3. Once you have entered the required dates you need covered either using the

requirements calendar or the Add Day Pattern options, you will see on the left hand side

of the screen the list of supply teachers that meet the requirements of your booking

and are available to be booked. You can browse candidates in a number of ways:




	 
	- Scroll through the list as it appears


	- Scroll through the list as it appears


	- Scroll through the list as it appears



	- Search for a particular teacher using the search bar


	- Search for a particular teacher using the search bar



	- To search for teachers by postcode, click Actions > Filter > In the Column Field

select Postcode > In the Operator field select Contains > In the Expression Field

put in a postcode/part of a postcode > Click Apply, e.g. if you only want to consider

teachers in the surrounding area with a G Postcode then enter G in the Expressions

field


	- To search for teachers by postcode, click Actions > Filter > In the Column Field

select Postcode > In the Operator field select Contains > In the Expression Field

put in a postcode/part of a postcode > Click Apply, e.g. if you only want to consider

teachers in the surrounding area with a G Postcode then enter G in the Expressions

field



	- To find teacher that are approved to work in Roman Catholic schools, click Actions

> Filter > In the Column Field select RC Approved > In the Operator column select

= > In the Expression field select Y > Apply. You will then be able to see all RC

approved teachers.


	- To find teacher that are approved to work in Roman Catholic schools, click Actions

> Filter > In the Column Field select RC Approved > In the Operator column select

= > In the Expression field select Y > Apply. You will then be able to see all RC

approved teachers.




	 
	You can view the details of a teacher by clicking the yellow pencil to the left of their name.


	 
	4. When you come across some teachers you would like to try booking, you can select

Shortlist ( ), a pop up box will ask you to confirm that person for your shortlist,

select Yes. Anyone you shortlist will move in to the Shortlist tab along with all their

contact information to allow you to try getting in touch with them by telephone using the

number provided or by email to see if they can work in your school. Choosing email will

send the following email to teachers on your shortlist:
	4. When you come across some teachers you would like to try booking, you can select

Shortlist ( ), a pop up box will ask you to confirm that person for your shortlist,

select Yes. Anyone you shortlist will move in to the Shortlist tab along with all their

contact information to allow you to try getting in touch with them by telephone using the

number provided or by email to see if they can work in your school. Choosing email will

send the following email to teachers on your shortlist:
	4. When you come across some teachers you would like to try booking, you can select

Shortlist ( ), a pop up box will ask you to confirm that person for your shortlist,

select Yes. Anyone you shortlist will move in to the Shortlist tab along with all their

contact information to allow you to try getting in touch with them by telephone using the

number provided or by email to see if they can work in your school. Choosing email will

send the following email to teachers on your shortlist:
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	Request availability for Supply Booking

If contacting the school in relation to this requirement please quote Ref: BR\ED010\001100.

Dear John Smith,

Our records indicate that you may be available to provide tuition in Computing at Bearsden

Academy on the date(s) shown below.

11/08/2021 Whole Day

20/08/2021 Whole Day

If you are available to fill this booking, please contact the school office at:

office@bearsdenacademy.e-dunbarton.sch.uk


	 
	 
	You can remove a teacher from your shortlist by clicking the Remove option; this will

return you to the All Teachers Tab.


	 
	 
	5. Once you have contacted a teacher and confirmed the booking with them, you can then

click Book ( ) to book the teacher on the database. Again a box will pop up asking

you to confirm you want to book that teachers; select Yes. You will now be able to see

the booking on the request calendar and on the Booking Tab.


	5. Once you have contacted a teacher and confirmed the booking with them, you can then

click Book ( ) to book the teacher on the database. Again a box will pop up asking

you to confirm you want to book that teachers; select Yes. You will now be able to see

the booking on the request calendar and on the Booking Tab.


	5. Once you have contacted a teacher and confirmed the booking with them, you can then

click Book ( ) to book the teacher on the database. Again a box will pop up asking

you to confirm you want to book that teachers; select Yes. You will now be able to see

the booking on the request calendar and on the Booking Tab.




	Figure
	 
	 
	Figure
	 
	Once you have booked a teacher on the system, you can then send a confirmation e-mail

providing information about the booking and a link to the EDC Hub to access the Teacher

Attendance Form and guidance. *Please Note* when calling a supply teacher and

confirming a booking with them, ask them to check their SPAM folder for this email if it does

not arrive right away.


	 
	- When on the booked tab, next to the teachers name click the button that says email


	- When on the booked tab, next to the teachers name click the button that says email


	- When on the booked tab, next to the teachers name click the button that says email



	- In the box that appears, you will see the e-mail address in the system for that

teacher. If this is correct, click send


	- In the box that appears, you will see the e-mail address in the system for that

teacher. If this is correct, click send



	- The following e-mail will be sent to the teacher with information about the booking:


	- The following e-mail will be sent to the teacher with information about the booking:




	 
	Confirmation of Supply Booking

If contacting the school in relation to this booking please quote Ref: BR\ED012\000607.
	This email is to confirm that John Smith, (employee no - :1234567), has been booked as a supply

teacher at Douglas Academy on the date(s) shown in the table below.

16/08/2021 Whole Day

17/08/2021 Whole Day

18/08/2021 Whole Day

Important points to note:

School holiday dates within booking periods are excluded from payment and should not be

submitted as part of your Teacher Attendance Form.

It is your responsibility to submit a completed Teacher Attendance Form o time to the school office

for processing.

Please complete all sections of the form electronically and email it to the school office at:

office@douglas.e-dunbarton.sch.uk

Forms should be submitted by the last Friday of every month - failure to submit forms on time

could lead to delays in payment.

Guidance on completion of the Teacher Attendance Form together with blank forms can be found


	This email is to confirm that John Smith, (employee no - :1234567), has been booked as a supply

teacher at Douglas Academy on the date(s) shown in the table below.

16/08/2021 Whole Day

17/08/2021 Whole Day

18/08/2021 Whole Day

Important points to note:

School holiday dates within booking periods are excluded from payment and should not be

submitted as part of your Teacher Attendance Form.

It is your responsibility to submit a completed Teacher Attendance Form o time to the school office

for processing.

Please complete all sections of the form electronically and email it to the school office at:

office@douglas.e-dunbarton.sch.uk

Forms should be submitted by the last Friday of every month - failure to submit forms on time

could lead to delays in payment.

Guidance on completion of the Teacher Attendance Form together with blank forms can be found


	here
	here

	.

This link can only be accessed from an EDC device. If you cannot access this link please contact the

school office.

Finally, please be aware that your payslip will show the total time worked in hours and not days.



	 
	 
	 
	Removing information from a booking
	Removing information from a booking
	Figure

	 
	If you need to remove a teacher from a booking, you can either click each day on the

request calendar and select either:


	 
	- Delete Booking: This will remove the teacher from that particular day. This could be

because you contact a teacher and there is a day in your requirement that they can

not do, in which case you will need to book another teacher to cover that one day


	- Delete Booking: This will remove the teacher from that particular day. This could be

because you contact a teacher and there is a day in your requirement that they can

not do, in which case you will need to book another teacher to cover that one day


	- Delete Booking: This will remove the teacher from that particular day. This could be

because you contact a teacher and there is a day in your requirement that they can

not do, in which case you will need to book another teacher to cover that one day



	- Delete Requirement: This will remove that day as a requirement e.g. that day no

longer requires a teacher to provide supply cover on it


	- Delete Requirement: This will remove that day as a requirement e.g. that day no

longer requires a teacher to provide supply cover on it




	 
	Figure
	You can also delete the whole request by selecting Delete on the right

hand side of the screen to start the requirement again


	 
	 
	 
	 
	 
	 
	 
	 
	Once you have booked a teacher, you will see that the information at the top of the

booking has updated and the status of the booking has changed from REQ (required)

to BOO (Booked) and that the number of slots they have been booked for has been

filled. Also the start date and end date of the cover is shown. If you know the Reason

code at this stage you can add it at the top and select Apply Changes to save the


	change.


	 
	 
	Figure
	 
	If you need to make any amendments to a booking, from the Shortlisting – Main List page,

select the yellow pencil next to a booking to do so


	 
	 
	Teacher Usage Report

 
	 
	 
	The Teacher Usage report provides a breakdown of supply teacher usage and captures all

supply books completed on the system. It can be accessed from the menu down the left

hand side of the database


	 
	 
	Figure
	 
	The report allows you to filter on all column headers as required. Further refinement of data

is available by clicking directly on blue highlighted headers
	 
	 
	Figure
	 
	There are currently four booking reports available:
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	TR
	Span
	Primary Report 
	Primary Report 

	This is the default report and includes all

data for respective school(s). If you have

access to more than one school, you can

filter by individual school


	This is the default report and includes all

data for respective school(s). If you have

access to more than one school, you can

filter by individual school




	TR
	Span
	Bookings by school 
	Bookings by school 

	This report filters by school name. If you

have access to more than one school you

can filter by individual school.


	This report filters by school name. If you

have access to more than one school you

can filter by individual school.


	 
	To see what teachers you have booked to

work in your schools over a certain period,

filter this report by Date for the date range

you are interested in




	TR
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	Bookings by teacher 
	Bookings by teacher 

	This report filters by teacher name


	This report filters by teacher name




	TR
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	Total Bookings per school 
	Total Bookings per school 

	This provides the total number of bookings

by school. This can be filtered by school

name if you have access to more than one

school


	This provides the total number of bookings

by school. This can be filtered by school

name if you have access to more than one

school






	 
	 
	Saving Custom Reports
	Saving Custom Reports
	Figure

	 
	Using the filtering functions available, you can also create your own custom report to include

only the information you are interested from all that is available. This report can then be

saved and used as and when required. This report will only be unique to your establishment

and will not appear on any other schools page.


	 
	Once you have made your report with the filters you want, click Actions > Report > Save

Report. You can then export this report you have made as a CSV, PDF or Email by

selecting Actions > Download


	 
	Saving a report Download a report
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	Timesheets

 
	 
	The Timesheets part of this process is to be used for both Supply Teachers and

Permanent Teachers working additional hours, and is split in to two sections:


	 
	 Supply teacher/perm additional hours teacher fills in digital timesheet of hours worked


	 Supply teacher/perm additional hours teacher fills in digital timesheet of hours worked


	 Supply teacher/perm additional hours teacher fills in digital timesheet of hours worked



	 School create timesheet on database with information for Payroll to pay teacher


	 School create timesheet on database with information for Payroll to pay teacher




	 
	 
	  Process for Supply Teacher/Permanent Teacher working additional Hours

 
	 
	When a supply teacher is booked on the database, they will receive a confirmation e-mail

with a link to the East Dunbartonshire Council website, where they will see Teacher

Attendance Form (This can be found within Employee Zone > Policy & Procedures). If

there is a Permanent Teacher working additional hours, they do not need to be booked out

on the system, therefore they will need to have the link to this page sent to them via e-mail.


	 
	For school office info, the forms can be found on the EDC Website and the Hub at the links

below:


	 
	 East Dunbartonshire Website


	 East Dunbartonshire Website


	 East Dunbartonshire Website


	 East Dunbartonshire Website


	 East Dunbartonshire Website



	 


	 Education Processes (SEEMiS Replacement) on the Hub


	 Education Processes (SEEMiS Replacement) on the Hub


	 Education Processes (SEEMiS Replacement) on the Hub


	 Education Processes (SEEMiS Replacement) on the Hub



	 



	 
	 
	The teacher must complete the timesheet below electronically, filling in the dates and hours

they have worked in one school. Once they have signed and dated the timesheet, they

should then e-mail the completed time sheet to the school office. In order to be paid on

time, the teacher must submit the timesheet by last Friday of every month.


	 
	Please Note:


	 This time sheet must be completed electronically and then e-mailed to the school

office. A physical copy should not be printed and filled in.


	 This time sheet must be completed electronically and then e-mailed to the school

office. A physical copy should not be printed and filled in.


	 This time sheet must be completed electronically and then e-mailed to the school

office. A physical copy should not be printed and filled in.



	 The booking confirmation e-mail contains information the teacher needs to complete

the time sheet, ie. their employee number, school office e-mail address


	 The booking confirmation e-mail contains information the teacher needs to complete

the time sheet, ie. their employee number, school office e-mail address



	 It is the Teachers responsibility to ensure that their time sheet is completed correctly

and submitted on time. Failure to do this could lead to delays and Payroll processing

could carry forward to the following month. Direct the teacher to the information box

on the timesheet for information about this


	 It is the Teachers responsibility to ensure that their time sheet is completed correctly

and submitted on time. Failure to do this could lead to delays and Payroll processing

could carry forward to the following month. Direct the teacher to the information box

on the timesheet for information about this



	 If a teacher has worked in more than one school in the one pay period, they must

complete a separate sheet for each school


	 If a teacher has worked in more than one school in the one pay period, they must

complete a separate sheet for each school




	 
	 
	Inputting  timesheet  information  on the database

 
	 
	The information on the teachers digital timesheet return must be entering in to the Supply

Teacher Database in order to be processed by payroll and the teacher paid.
	 
	 
	Creating a timesheet on the system
	Creating a timesheet on the system
	Figure

	1. Once a teacher has emailed their digital timesheet to the school office where they

have worked, an admin member will need to complete the sections marked OFFICE

ONLY on the sheet and save the complete timesheet in an appropriate place for your

schools own audit purposes


	1. Once a teacher has emailed their digital timesheet to the school office where they

have worked, an admin member will need to complete the sections marked OFFICE

ONLY on the sheet and save the complete timesheet in an appropriate place for your

schools own audit purposes


	1. Once a teacher has emailed their digital timesheet to the school office where they

have worked, an admin member will need to complete the sections marked OFFICE

ONLY on the sheet and save the complete timesheet in an appropriate place for your

schools own audit purposes




	Table
	TBody
	TR
	Span
	TH
	Span
	Section of timesheet  

	TH
	Span
	Data required

 


	TR
	Span
	 
	 
	Figure

	For each date that has hours worked

against it, select the Booking type from the

list provided


	For each date that has hours worked

against it, select the Booking type from the

list provided


	 
	Supply = less than 2 days


	Fixed Term = more than 2 days


	For Permanent teachers doing additional

hours leave this blank




	TR
	Span
	 
	 
	Figure

	For each date that has hours worked

against it, select the correct Reason Code

for each day from the list provided. If you do

not know the reason code, contact your

SSC/SSM and they can provide this

information


	For each date that has hours worked

against it, select the correct Reason Code

for each day from the list provided. If you do

not know the reason code, contact your

SSC/SSM and they can provide this

information




	TR
	Span
	 
	 
	Figure


	TR
	Span
	Supply Teachers will add up the total number of days and hours they have worked, as well

as total number of days/hours they have been off sick. Please check that the totals they

have entered are correct and amend if necessary.


	Supply Teachers will add up the total number of days and hours they have worked, as well

as total number of days/hours they have been off sick. Please check that the totals they

have entered are correct and amend if necessary.


	If a teacher has ticked any date to say they were sick, then also add this information up

and put the total in days and hours in the Sick Absence section, and follow the current

process that is in place for paying supply teacher who have been off and are entitled to

sick pay






	 
	2. Once you have filled in the OFFICE ONLY sections of the timesheet, Save the

timesheet in an appropriate place. Now the information on the timesheet can be input

in to the database


	2. Once you have filled in the OFFICE ONLY sections of the timesheet, Save the

timesheet in an appropriate place. Now the information on the timesheet can be input

in to the database


	2. Once you have filled in the OFFICE ONLY sections of the timesheet, Save the

timesheet in an appropriate place. Now the information on the timesheet can be input

in to the database




	 
	3. Within the database, along the left hand side select Timesheets and then select

Create to make a new one.


	3. Within the database, along the left hand side select Timesheets and then select

Create to make a new one.


	3. Within the database, along the left hand side select Timesheets and then select

Create to make a new one.




	 
	Figure
	 
	Figure
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	Figure
	 
	4. A Create Timesheet box will

appear; fill in all fields:


	4. A Create Timesheet box will

appear; fill in all fields:


	4. A Create Timesheet box will

appear; fill in all fields:




	 
	 
	 
	 
	 
	 
	Table
	TBody
	TR
	Span
	TH
	Span
	Field  

	TH
	Span
	Data Required

 


	TR
	Span
	Start Date (1st Monday) 
	Start Date (1st Monday) 

	Select the first Monday for the week the teacher started

working in your school e.g. if a teacher did Wednesday 21st –

Friday 23rd in a school, select the date Monday 19th


	Select the first Monday for the week the teacher started

working in your school e.g. if a teacher did Wednesday 21st –

Friday 23rd in a school, select the date Monday 19th




	TR
	Span
	School 
	School 

	This will auto-populate with your school and cannot be

changed

(those with Cluster permissions will be able to select from the

schools in their Cluster)


	This will auto-populate with your school and cannot be

changed

(those with Cluster permissions will be able to select from the

schools in their Cluster)




	TR
	Span
	Teacher 
	Teacher 

	Select the name of the teacher who has submitted the

timesheet, confirming the employee number on the database

matches the one on the sheet (Use employees numbers to

differentiate between teachers with the same name)


	Select the name of the teacher who has submitted the

timesheet, confirming the employee number on the database

matches the one on the sheet (Use employees numbers to

differentiate between teachers with the same name)




	TR
	Span
	Date Submitted 
	Date Submitted 

	Auto-populates to date timesheet is created


	Auto-populates to date timesheet is created




	TR
	Span
	Reason Code 
	Reason Code 

	Enter Reason code, contact your SSC/SSM if unknown


	Enter Reason code, contact your SSC/SSM if unknown




	TR
	Span
	Contract Type 
	Contract Type 

	Distinguishes between teachers who have worked supply and

those who are permanent teachers working additional hours.

Select the correct option based off the information the teacher

has put on their sheet and the time they have worked
	Distinguishes between teachers who have worked supply and

those who are permanent teachers working additional hours.

Select the correct option based off the information the teacher

has put on their sheet and the time they have worked




	 
	Once you have filled in all the fields, select Create.


	Figure
	5. When the timesheet has been created, you will be taken to the Timesheet Entry

Form. Here, you will see at a glance some contact information about the teacher

along with some editable fields.


	5. When the timesheet has been created, you will be taken to the Timesheet Entry

Form. Here, you will see at a glance some contact information about the teacher

along with some editable fields.


	5. When the timesheet has been created, you will be taken to the Timesheet Entry

Form. Here, you will see at a glance some contact information about the teacher

along with some editable fields.




	 
	Table
	TBody
	TR
	Span
	TH
	Span
	Field  

	TH
	Span
	Data Required

 


	TR
	Span
	Contract Type 
	Contract Type 

	Pre-populated with type selected when

creating timesheet. Can be changed

between:


	Pre-populated with type selected when

creating timesheet. Can be changed

between:


	 
	 Permanent Staff


	 Permanent Staff


	 Permanent Staff



	 Supply Teacher (< 2 days)


	 Supply Teacher (< 2 days)



	 Supply Teacher (fixed term)


	 Supply Teacher (fixed term)






	TR
	Span
	Reason Code 
	Reason Code 

	Pre-populated with Reason Code selected

when creating timesheet


	Pre-populated with Reason Code selected

when creating timesheet




	TR
	Span
	School 
	School 

	This field is only to be filled in if the

timesheet is for a Permanent Teacher

working additional hours. Choose the name

of the school they have a permanent

contract at from the list


	This field is only to be filled in if the

timesheet is for a Permanent Teacher

working additional hours. Choose the name

of the school they have a permanent

contract at from the list




	TR
	Span
	Passed to Office 
	Passed to Office 

	Auto-populates to the date that the

timesheet was created


	Auto-populates to the date that the

timesheet was created




	TR
	Span
	Signed by Teacher 
	Signed by Teacher 

	This is the date that the teacher has e�mailed timesheet to school office. Only

saved to record when Apply Changes is

clicked


	This is the date that the teacher has e�mailed timesheet to school office. Only

saved to record when Apply Changes is

clicked




	TR
	Span
	Processed by SSC/SSM/Admin 
	Processed by SSC/SSM/Admin 

	The field will auto-populate when Awaiting

Approval button is pressed to change

status of timesheet to Awaiting Approval


	The field will auto-populate when Awaiting

Approval button is pressed to change

status of timesheet to Awaiting Approval




	TR
	Span
	Approved by Head Teacher 
	Approved by Head Teacher 

	Once the Head Teacher has approved the

timesheets via the Head Teacher Summary

report, this field will auto-populate when

Complete button is pressed to change the

status of timesheet to Complete


	Once the Head Teacher has approved the

timesheets via the Head Teacher Summary

report, this field will auto-populate when

Complete button is pressed to change the

status of timesheet to Complete




	TR
	Span
	Sent to Payroll 
	Sent to Payroll 

	Auto-populate when timesheet status is

changed from Complete to Sent to Payroll

on the Timesheet Main List page
	Auto-populate when timesheet status is

changed from Complete to Sent to Payroll

on the Timesheet Main List page




	 
	 
	 
	 
	Status of Timesheets - Overview
	Status of Timesheets - Overview
	Figure

	There are a number of different statuses that timesheets can be on the database which

relate to various stages of the process. What you are able to do on a timesheet when it is at

each status is unique also.


	 
	Table
	TBody
	TR
	Span
	TD
	Span
	Status  

	TD
	Span
	Description of Status  

	TD
	Span
	Access

 


	TR
	Span
	In Progress 
	In Progress 

	Status that record is automatically set to when timesheet is

created on system.


	Status that record is automatically set to when timesheet is

created on system.


	Functions available:


	- Input hours against days worked by teacher


	- Input hours against days worked by teacher


	- Input hours against days worked by teacher



	- Input/edit reason codes against days worked


	- Input/edit reason codes against days worked



	- Add a note to record


	- Add a note to record



	- Delete record


	- Delete record




	Final stage of status: SSC/SSM to check details on timesheet

records are correct, Once checked, all records to be changed to

Awaiting Approval by selecting


	Figure

	Everyone


	Everyone




	TR
	Span
	Awaiting Approval 
	Awaiting Approval 

	Selecting Request Approval button on timesheet record sets this

status and populates SSC/SSM/Adm date field. Head Teacher

Report will run off records sitting at this status. Report must be

downloaded from system and e-mail to Head Teacher for

approval, with SSM/SSC cc’d.


	Selecting Request Approval button on timesheet record sets this

status and populates SSC/SSM/Adm date field. Head Teacher

Report will run off records sitting at this status. Report must be

downloaded from system and e-mail to Head Teacher for

approval, with SSM/SSC cc’d.


	 
	Functions available:


	- Input hours against days worked by teacher


	- Input hours against days worked by teacher


	- Input hours against days worked by teacher



	- Input/edit reason codes against days worked


	- Input/edit reason codes against days worked



	- Add a note to record


	- Add a note to record



	- Delete record


	- Delete record




	Final stage of status: Head Teacher gives approval for all records

sitting on system via e-mail. All records to be changed to

Complete by selecting


	Figure

	Everyone


	Everyone




	TR
	Span
	Complete 
	Complete 

	Selecting Complete Timesheet button on timesheet record sets

this status and populates HT Approval date field. Records are

locked at this status and no changes can be made without

unlocking first. Payroll Report will run off records sitting at this

status. Report must be downloaded from system and e-mailed to

Payroll within same e-mail chain as Head Teachers Approval, with

SSC/SSM cc’d.


	Selecting Complete Timesheet button on timesheet record sets

this status and populates HT Approval date field. Records are

locked at this status and no changes can be made without

unlocking first. Payroll Report will run off records sitting at this

status. Report must be downloaded from system and e-mailed to

Payroll within same e-mail chain as Head Teachers Approval, with

SSC/SSM cc’d.


	Functions available:


	- Unlock timesheet to revert back to In Progress if error

noticed on record before sending Payroll Report


	- Unlock timesheet to revert back to In Progress if error

noticed on record before sending Payroll Report


	- Unlock timesheet to revert back to In Progress if error

noticed on record before sending Payroll Report





	SSC/SSM


	SSC/SSM






	Table
	TBody
	TR
	TD
	TD
	Span
	- Add a note


	- Add a note


	- Add a note


	- Add a note




	Final stage of status: Payroll Report emailed to Payroll for

processing. Do not make any more changes to records/statuses

on the system until Finance contact to advise differently




	TR
	Span
	Sent To Payroll 
	Sent To Payroll 

	Selecting Send to Payroll button when using the add bulk feature

changes records sitting at Complete to this status and populates

Sent Payroll date field. This should only be done once Finance

contact schools to advise that recharge has been complete.


	Selecting Send to Payroll button when using the add bulk feature

changes records sitting at Complete to this status and populates

Sent Payroll date field. This should only be done once Finance

contact schools to advise that recharge has been complete.


	 
	Functions available:


	- Add a note


	- Add a note


	- Add a note




	Once record is sitting at this status, it can not be unlocked to be

amended, or deleted. If no errors have been identified during

processing, then changing records to this status is the final step in

the process and prevents old records already submitted to Payroll

pulling through on to future reports.



	No users


	No users




	TR
	Span
	Void 
	Void 

	The VOID status should only be used if an overpayment error

has been identified and the Payroll Report has been submitted

but Payroll processing is not complete.


	The VOID status should only be used if an overpayment error

has been identified and the Payroll Report has been submitted

but Payroll processing is not complete.


	 
	The entire timesheet for the employee in question must be

marked as void – please refer to 
	The entire timesheet for the employee in question must be

marked as void – please refer to 
	Timesheets - Guidance on

Correcting Entries 
	Timesheets - Guidance on

Correcting Entries 

	on the Hub.



	 
	Only records with status Complete can be changed to Void by

selecting . Once at this status, it cannot be

unlocked to be amended, or deleted.


	Figure
	 
	Functions available:


	- Add a note


	- Add a note


	- Add a note




	A note must be added to Void Records with information on the

error identified and wat mitigating action is being taken (a note

must also be added to the new record that is create to correct the

identified error)


	Note: Do not VOID a timesheet if the Payroll processing has

been complete – please refer to 
	Note: Do not VOID a timesheet if the Payroll processing has

been complete – please refer to 
	Timesheets - Guidance on

Correcting Entries 
	Timesheets - Guidance on

Correcting Entries 

	on the Hub and refer to your SSC / SSM




	SSC/SSM
	SSC/SSM




	 
	 
	 
	 
	 
	Entering hours worked on to a timesheet


	Entering hours worked on to a timesheet


	Figure

	 
	At the bottom of the page there is a long list of dates Mon-Fri. This is 5 weeks from the start

date (1st Monday) that was chosen when the timesheet was created as there are 5 weeks

worth of hours a teacher can work in a pay period. Please note that only days that have

Hours entered against them will pull through to the report for Payroll so teachers will only be

paid for day that have hours entered against them.


	 
	Click on the yellow pencil against a day the teacher has worked, and in the Timesheet

Details box that appears, fill in the following fields:


	 
	 Hrs: The hours the teacher has worked on that particular day according to their

timesheet.


	 Hrs: The hours the teacher has worked on that particular day according to their

timesheet.


	 Hrs: The hours the teacher has worked on that particular day according to their

timesheet.



	 Sick: Select Yes/No from the drop down if the teacher’s digital timesheet reports them

as sick for that day


	 Sick: Select Yes/No from the drop down if the teacher’s digital timesheet reports them

as sick for that day



	 Reason Code: This can be changed here if a particular day a teacher has worked was

under a different reason code. Your SSC/SSM will tell you if this is the case.


	 Reason Code: This can be changed here if a particular day a teacher has worked was

under a different reason code. Your SSC/SSM will tell you if this is the case.



	 Contract Type: Select if the teacher worked that day as supply or permanent doing

additional hours


	 Contract Type: Select if the teacher worked that day as supply or permanent doing

additional hours




	 
	*PLEASE NOTE* If a teacher in your school works under a different reason code in the

morning and the afternoon, then you must create two timesheets – one with morning

hours, and one with afternoon hours.


	 
	On the Stats Tab ( ), you will be able to see some more information:


	Figure
	 
	- Start and end date of the pay period


	- Start and end date of the pay period


	- Start and end date of the pay period



	- Total number of days and hours entered on the sheet


	- Total number of days and hours entered on the sheet



	- The estimated cost of the booking (£270 is the average daily rate in the system for

the cost of a supply teacher for one day, therefore 270 x no. of hours worked =

estimated total for teacher)


	- The estimated cost of the booking (£270 is the average daily rate in the system for

the cost of a supply teacher for one day, therefore 270 x no. of hours worked =

estimated total for teacher)




	 
	 
	Figure
	 
	On the Notes Tab ( ), you will be able to add notes to a timesheet record, no

matter the status of the timesheet.


	Figure
	 
	 
	Adding hours onto a timesheet in bulk
	Adding hours onto a timesheet in bulk
	Figure

	 
	If a teacher has worked for whole weeks at a time for a few weeks with the same reason

code, e.g. a teacher has worked for 3 weeks, 7 hours each day, under reason code 24 (Long

Term Absence over 9 days), you are able to load that information in to the system in one go.


	 
	 
	1. Click Add Bulk on the right hand side of the screen


	1. Click Add Bulk on the right hand side of the screen


	1. Click Add Bulk on the right hand side of the screen




	Figure
	 
	2. In the pop-up box that appears, enter the first date that the teacher has entered on

their time sheet in the Start Date field and the last date on their time sheet in the End

Date field.


	2. In the pop-up box that appears, enter the first date that the teacher has entered on

their time sheet in the Start Date field and the last date on their time sheet in the End

Date field.


	2. In the pop-up box that appears, enter the first date that the teacher has entered on

their time sheet in the Start Date field and the last date on their time sheet in the End

Date field.




	 
	Then, select the Reason Code for all of those days, as well as the contract type for

the teacher. The hours are set to 7 automatically, so please change this if required,

then select Apply. You will then see that all the available dates between the start and

end date you entered will have the hour worked, contract type and reason code

against them.


	 
	3. If you have entered hours against a day and need to remove them, click the yellow

pencil and then just remove the number of hours that was entered and click Apply

Changes, then you will see that day no longer has hours against it.


	3. If you have entered hours against a day and need to remove them, click the yellow

pencil and then just remove the number of hours that was entered and click Apply

Changes, then you will see that day no longer has hours against it.


	3. If you have entered hours against a day and need to remove them, click the yellow

pencil and then just remove the number of hours that was entered and click Apply

Changes, then you will see that day no longer has hours against it.




	 
	 
	 
	Entering hours worked on an In-service day/Holiday


	Entering hours worked on an In-service day/Holiday


	Figure

	 
	A school calendar held within the background of system prevents the input of hours on days

which are Holidays (non-working schools days). Any day that is a school holiday where

teachers would not work will have the symbol below next to it, as well as information in the

Holiday Description column of a timesheet record.


	 
	 
	Figure
	 
	 
	 
	 
	In-service days are also recorded in the system. These days will have the green symbol

below, next to them, as well as In-Service Day in the Holiday Description column of a

timesheet record. When adding hours In Bulk, any in-service days worked in the date range

you select will not pull through as hours worked at the bottom of the page.


	 
	As some teachers do work on In-service days, Schools can manually enter hours worked

on that day using the yellow pencil.


	 
	 
	Figure
	 
	 
	Requesting Approval
	Requesting Approval
	Figure

	 
	Once you have input all information from the teachers’ digital timesheet in to the database

and have checked all information is correct, please contact your SSM/SSC to let them

know that the entry is ready for them to review.


	 
	Once the SSC/SSM has confirmed timesheets are ready to be approved by Head Teacher,

click Request Approval to change timesheet status to Awaiting Approval. This will auto�populate the Processed by SSC/SSM/Admin field with the date. This can be done


	individually or using the Bulk function (steps to do this are on page 23)


	 
	   
	Figure
	Figure
	>


	 
	 
	 
	Timesheet Report

 
	 
	Timesheet Reports have been created to provide information from the system relating to

hours teachers have worked. These reports can be sent to Head Teachers to approve

timesheet and Payroll to process timesheets. The reports must be approved by the Head

Teacher before sending to Payroll for processing.


	 
	Please note - there may be changes made to values or codes within the background of the

system over time, e.g. the average daily cost for a supply teacher is reviewed each year and

therefore could change or reason codes could be amended. Be aware - when these values

are changed, they impact the new records added in the future, but also all historical records

sitting in the system. Therefore, for Schools to review historical information, please rely on

days / hours worked and not cost OR refer to the reports downloaded and saved direct from

the system at the time of processing.


	 
	When running reports from the Supply Teacher Database, please ensure that the

appropriate filters are on each report so only the required information pulls through. If

filters are missing from report, close down the database and re-open to reset.


	 
	 
	Head Teacher Summary – the correct filters are:


	 
	 
	Figure
	 
	 
	Payroll Report - the correct filters are:


	 
	 
	Figure
	 
	 
	 
	 
	 
	Table
	TBody
	TR
	Span
	TH
	Span
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	TH
	Span
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	TH
	Span
	STATUS report

pulls from

 


	TR
	Span
	Primary Report 
	Primary Report 

	This report contains all information relating 
	This report contains all information relating 

	Does not pull
	Does not pull




	Table
	TBody
	TR
	Span
	TH
	Span
	Report Name  

	TH
	Span
	Description of Report  

	TH
	Span
	STATUS report

pulls from

 


	TR
	TD
	Span
	to timesheets for your school on the

system. It can be filtered in any way you

need to provide information about your

records for your school using the Filter

option. It is also possible to create custom

reports with this information.


	to timesheets for your school on the

system. It can be filtered in any way you

need to provide information about your

records for your school using the Filter

option. It is also possible to create custom

reports with this information.



	on a status


	on a status




	TR
	Span
	Head Teacher Summary 
	Head Teacher Summary 

	Provides high level information for Head

Teachers about total number of hours a

teacher has worked in their school and the

estimated cost. Report only pulls

through timesheets marked as Awaiting

Approval. Timesheets with the status

In Progress or Complete will NOT be

included within this report.


	Provides high level information for Head

Teachers about total number of hours a

teacher has worked in their school and the

estimated cost. Report only pulls

through timesheets marked as Awaiting

Approval. Timesheets with the status

In Progress or Complete will NOT be

included within this report.



	AWAITING

APPROVAL


	AWAITING

APPROVAL




	TR
	Span
	Payroll Report 
	Payroll Report 

	Provides detailed information about the

hours a teacher has worked in school

which Payroll require to process a

timesheet. Report filtered to only pull

through timesheets marked as Complete.


	Provides detailed information about the

hours a teacher has worked in school

which Payroll require to process a

timesheet. Report filtered to only pull

through timesheets marked as Complete.


	Timesheets with the status In Progress

or Awaiting Approval will NOT be

included within this report.


	 
	This report can also be provided to Head

Teachers / SSM / SSCs if a more

breakdown of the Head Teacher Summary

is required / preferred.



	COMPLETE


	COMPLETE




	TR
	Span
	Void Report 
	Void Report 

	Provides detail on records that have been

marked as VOID on the system, following

identification of an error to a record during

Payroll Processing. Can be filtered by date

if required


	Provides detail on records that have been

marked as VOID on the system, following

identification of an error to a record during

Payroll Processing. Can be filtered by date

if required



	VOID


	VOID






	 
	 
	 
	How to create Custom Reports
	How to create Custom Reports
	Figure

	 
	The database allows you to create your own custom reports from any of the different pieces

of information held within the system using the Primary Report. This may be useful to help

you to identify amounts spent on Individual / Groups of teachers or Individual / Groups of

Reason Codes, or provide specific information requested by your Head Teacher.


	 
	The Reports can be downloaded into Excel and then filtered and sorted for whatever

information you are required to check.


	 
	1. On the Timesheet Report section of the system, select 1. Primary Report from the

drop down lists of reports available


	1. On the Timesheet Report section of the system, select 1. Primary Report from the

drop down lists of reports available


	1. On the Timesheet Report section of the system, select 1. Primary Report from the

drop down lists of reports available



	2. Click Action > Columns. This will show you all the different pieces of information

you can make a report on


	2. Click Action > Columns. This will show you all the different pieces of information

you can make a report on




	 
	 
	Figure
	 
	3. Using the buttons down the middle of the columns, move information you need in to

the Display In Report column, and any information you do not need in the Do not

display column.


	3. Using the buttons down the middle of the columns, move information you need in to

the Display In Report column, and any information you do not need in the Do not

display column.


	3. Using the buttons down the middle of the columns, move information you need in to

the Display In Report column, and any information you do not need in the Do not

display column.



	4. Once you have all the columns you require, click Apply


	4. Once you have all the columns you require, click Apply



	5. To save this report and rename, select Actions > Report > Save Report, then name

your report


	5. To save this report and rename, select Actions > Report > Save Report, then name

your report



	6. Your custom report will show under Private from the drop down list of reports and

can be ran any time.


	6. Your custom report will show under Private from the drop down list of reports and

can be ran any time.




	 
	 
	Figure
	 
	7. To delete a customer report, delete the filter showing on the report and select Apply

to the message that appears


	7. To delete a customer report, delete the filter showing on the report and select Apply

to the message that appears


	7. To delete a customer report, delete the filter showing on the report and select Apply

to the message that appears
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	Head Teacher Approval
	Head Teacher Approval
	Figure

	 
	To obtain Head Teacher approval:


	 
	1. Once the SSM/SSC has reviewed all timesheets and all

records have had their status changed to Awaiting

Approval, the report is ready to be run. Select Timesheet

Report from the menu on the left hand side


	1. Once the SSM/SSC has reviewed all timesheets and all

records have had their status changed to Awaiting

Approval, the report is ready to be run. Select Timesheet

Report from the menu on the left hand side


	1. Once the SSM/SSC has reviewed all timesheets and all

records have had their status changed to Awaiting

Approval, the report is ready to be run. Select Timesheet

Report from the menu on the left hand side
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	2. From the drop down list, select Head Teacher Summary


	2. From the drop down list, select Head Teacher Summary


	2. From the drop down list, select Head Teacher Summary




	 
	 
	Figure
	 
	3. Ensure the following filters appear on the report (if they do not, add filter back on or

close down system and re-open to regenerate filters):


	3. Ensure the following filters appear on the report (if they do not, add filter back on or

close down system and re-open to regenerate filters):


	3. Ensure the following filters appear on the report (if they do not, add filter back on or

close down system and re-open to regenerate filters):




	 
	 
	Figure
	 
	This report will only show timesheets that have been marked as Awaiting Approval so you

must ensure all timesheets requiring Head Teacher approval has been changed to status,

Awaiting Approval.


	 
	The information on the Head Teacher Summary is identicial to that of the Payroll report; the

only difference between the two is what status it pulls from.


	 
	 
	Figure
	 
	4. To run the report to send to your Head Teacher, click on Actions > Download. In the

pop up box that appears select CSV. Save this document in an appropriate place and

then e-mail to your Head Teacher to approve the reports. Their e-mail signature is

sufficient for the timesheets to be actioned by Payroll.


	4. To run the report to send to your Head Teacher, click on Actions > Download. In the

pop up box that appears select CSV. Save this document in an appropriate place and

then e-mail to your Head Teacher to approve the reports. Their e-mail signature is

sufficient for the timesheets to be actioned by Payroll.


	4. To run the report to send to your Head Teacher, click on Actions > Download. In the

pop up box that appears select CSV. Save this document in an appropriate place and

then e-mail to your Head Teacher to approve the reports. Their e-mail signature is

sufficient for the timesheets to be actioned by Payroll.




	 
	 
	It is vital that Head Teachers are familiar with the Head Teacher Report and understand the

requirements as the budget holder, to thoroughly check timesheet submissions each month,

as this is key to identifying any anomalies and preventing errors before the Payroll

processing takes place.


	When reviewing the report each month, Head Teacher should:


	 examine every entry within the report prior to approving to ensure the details are

correct


	 ensure employees included in the report have undertaken Supply or additional

hours, within your own School, on the dates specified


	 ensure hours included in the report are accurate and in line with Supply or

additional hours worked, on the dates specified


	 query any estimated costs that don’t look quite right, with your SSC / SSM


	 query any suspected anomalies in the report with your SSC / SSM and ensure the

data within the report is correct before providing approval to progress to Payroll.
	 
	Head Teachers support in checking the report, prior to providing approval, will help to

identify any incorrect salary payments, allows for errors to be rectified before these are

processed by the Payroll Team and removes the need for time consuming investigations

when errors are identified too late.


	 
	 
	Once Head Teacher approval has been provided via e-mail, the status of each timesheet

must be changed from Awaiting Approval to Complete. This can be done individually or

using the Bulk function (steps to do this are on page 28)
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	Unlocking timesheets


	Unlocking timesheets


	Figure

	 
	Once a timesheet has been marked as Complete, it is then locked and no more changes

can be made to the timesheet and it cannot be deleted. If an error has been made on a

timesheet that is locked after it has been approved by the Head Teacher, please refer to


	Once a timesheet has been marked as Complete, it is then locked and no more changes

can be made to the timesheet and it cannot be deleted. If an error has been made on a

timesheet that is locked after it has been approved by the Head Teacher, please refer to


	Timesheets - Guidance on Correcting Entries 
	Timesheets - Guidance on Correcting Entries 

	on the Hub and refer to your SSC / SSM.



	 
	 
	Sending Reports for Payroll Processing
	Sending Reports for Payroll Processing
	Figure

	 
	Once all timesheets for the current pay period have had their status changed to Complete,

the information must then be sent to Payroll for processing.


	 
	1. Go to the Timesheet Report section of the system, from the dropdown select Payroll

Report and ensure the following filters appear (if they do not, add filter back on or

close down system and re-open to regenerate filters):


	1. Go to the Timesheet Report section of the system, from the dropdown select Payroll

Report and ensure the following filters appear (if they do not, add filter back on or

close down system and re-open to regenerate filters):


	1. Go to the Timesheet Report section of the system, from the dropdown select Payroll

Report and ensure the following filters appear (if they do not, add filter back on or

close down system and re-open to regenerate filters):




	 
	 
	Figure
	 
	 
	2. Download CSV. Open the report and check that all information has pulled through

and is correct. Then save this document for your own audit records


	2. Download CSV. Open the report and check that all information has pulled through

and is correct. Then save this document for your own audit records


	2. Download CSV. Open the report and check that all information has pulled through

and is correct. Then save this document for your own audit records




	 
	3. Attach the downloaded Payroll Report to the Head Teacher approval email and

send to Payroll for processing. Existing Payroll cut-off dates still apply.


	3. Attach the downloaded Payroll Report to the Head Teacher approval email and

send to Payroll for processing. Existing Payroll cut-off dates still apply.


	3. Attach the downloaded Payroll Report to the Head Teacher approval email and

send to Payroll for processing. Existing Payroll cut-off dates still apply.




	 
	 
	For Audit purposes, Payroll must receive the Payroll report and the Head Teacher’s

approval email.


	 
	Once a timesheet has been marked as Complete, you cannot delete or amend the


	timesheet. If you realise there is an error on the timesheet after you have locked it and

before a report has gone to Payroll, you will need to contact your School support Co�ordinator or Manager who have the ability to do this.


	 
	If a changes needs to be made to a timesheet after the report has been submitted to Payroll,

you must request a Journal.


	 
	 
	 
	How to update status in Bulk
	How to update status in Bulk
	Figure

	 
	The status of timesheets can be changed in bulk, without needing to go in and out of each

individual record. This feature can help save time and make the process easier if you have

multiple timesheets in the system. Statuses can only be moved in the following order; you

cannot skip over a step using this function:


	 
	In Progress > Awaiting Approval


	Awaiting Approval > Complete


	Complete > Sent To Payroll


	 
	To change the status of records in bulk:


	 
	1. Go to the Timesheet – Main List page


	1. Go to the Timesheet – Main List page


	1. Go to the Timesheet – Main List page




	Figure
	 
	2. Here you will be able to see all records for timesheets in

your system. Down the left hand side of the screen, you

will see a tick box next to each record. Tick this box next

to each record whose status you would like to change


	2. Here you will be able to see all records for timesheets in

your system. Down the left hand side of the screen, you

will see a tick box next to each record. Tick this box next

to each record whose status you would like to change


	2. Here you will be able to see all records for timesheets in

your system. Down the left hand side of the screen, you

will see a tick box next to each record. Tick this box next

to each record whose status you would like to change




	 
	 
	 
	 
	 
	3. (To use the Select all Feature which ticks all records on the screen, you can filter on

the current status of the timesheets. E.g. If you are wanting to close down processed

timesheets, filter the status on Complete)


	3. (To use the Select all Feature which ticks all records on the screen, you can filter on

the current status of the timesheets. E.g. If you are wanting to close down processed

timesheets, filter the status on Complete)


	3. (To use the Select all Feature which ticks all records on the screen, you can filter on

the current status of the timesheets. E.g. If you are wanting to close down processed

timesheets, filter the status on Complete)




	 
	*Please note* If the ‘Select All’ box does not tick all records on first try, please refresh

the page and try again.


	 
	Figure
	 
	4. Once you have selected all of the records you need to change, select the status you


	4. Once you have selected all of the records you need to change, select the status you


	4. Once you have selected all of the records you need to change, select the status you




	want to change the records too using the three options from the top right hand

corner of the screen


	want to change the records too using the three options from the top right hand

corner of the screen


	want to change the records too using the three options from the top right hand

corner of the screen




	 
	 
	 
	Figure
	 
	5. A box will appear for you to confirm the date that these records are being changed.

This date will pull through on to each timesheet record. The field will default to

today’s date however you can enter a date in the past, then click OK


	5. A box will appear for you to confirm the date that these records are being changed.

This date will pull through on to each timesheet record. The field will default to

today’s date however you can enter a date in the past, then click OK


	5. A box will appear for you to confirm the date that these records are being changed.

This date will pull through on to each timesheet record. The field will default to

today’s date however you can enter a date in the past, then click OK




	 
	(e.g. if your SSC/SSM told you that your records were ready to go to the Head

Teacher on the Friday but you are not changing the status until Monday, you can

enter Friday’s Date when clicking Awaiting Approval)


	 
	6. You will see from the Main list that the status for the selected records will have

changed


	6. You will see from the Main list that the status for the selected records will have

changed


	6. You will see from the Main list that the status for the selected records will have

changed




	 
	 
	 
	Changing records from Complete to Sent to Payroll - for clear down ahead

of the next payrun
	Changing records from Complete to Sent to Payroll - for clear down ahead

of the next payrun
	Figure

	 
	Once the Payroll report has been sent to and processed by Payroll, those records need to

be closed down on the database so that they do not pull through on future Payroll Reports

and lead to duplicate payments.


	 
	This task should not be done on the system until Finance Team have issued the

finance journal for recharge for the current month’s PYOL’s. Once you have heard from

the Finance team with this information, records from the previous pay run should be

changed to Sent to Payroll BEFORE any new timesheets for the next pay run as put on to

the system.


	 
	To do this, the status of the timesheets that have been sent for processing need to be

changed from Complete to Sent To Payroll. This must be done using the Update in Bulk

function:


	 
	 
	*PLEASE NOTE* Once a record has been marked as Sent to Payroll it cannot be

unlocked or changed. If an error is found then contact your SSC/SSM and raise a

Journal if need be.


	 
	To change the status:


	 
	1. On the Timesheet – Main List page, select the check box for all records sitting at

Complete, or filter the page to show only Complete records


	1. On the Timesheet – Main List page, select the check box for all records sitting at

Complete, or filter the page to show only Complete records


	1. On the Timesheet – Main List page, select the check box for all records sitting at

Complete, or filter the page to show only Complete records




	 
	2. Double check that you have selected all the correct records against the Payroll


	2. Double check that you have selected all the correct records against the Payroll


	2. Double check that you have selected all the correct records against the Payroll




	Report


	Report


	Report




	 
	3. Click Sent To Payroll from the top right hand corner


	3. Click Sent To Payroll from the top right hand corner


	3. Click Sent To Payroll from the top right hand corner




	 
	4. Check the correct date is showing in the box that appears, then click OK


	4. Check the correct date is showing in the box that appears, then click OK


	4. Check the correct date is showing in the box that appears, then click OK




	 
	5. You will see that the status of all record selected is now Sent to Payroll. These

records will not pull through on to any reports for the next pay period


	5. You will see that the status of all record selected is now Sent to Payroll. These

records will not pull through on to any reports for the next pay period


	5. You will see that the status of all record selected is now Sent to Payroll. These

records will not pull through on to any reports for the next pay period




	 
	 
	 
	Errors with timesheets after submission to Payroll


	Errors with timesheets after submission to Payroll


	Figure

	 
	If an error is identified with a timesheet record any time after the Payroll Report has been

sent to Payroll, action will need to be taken to rectify this and changes made on the

database.


	 
	Depending on the type of error and at what stage in the process it is identified will dictate the

appropriate action required. Please refer to 
	Depending on the type of error and at what stage in the process it is identified will dictate the

appropriate action required. Please refer to 
	Timesheets - Guidance on Correcting Entries 
	Timesheets - Guidance on Correcting Entries 

	on

the Hub and refer to your SSC / SSM.



	 
	 
	 
	Void Status
	Void Status
	Figure

	 
	The Void Status should ONLY be used when:


	1. The timesheet record has a COMPLETE status and


	1. The timesheet record has a COMPLETE status and


	1. The timesheet record has a COMPLETE status and



	2. an overpayment error has been identified and


	2. an overpayment error has been identified and



	3. the Payroll Report has been submitted but Payroll processing is not complete.


	3. the Payroll Report has been submitted but Payroll processing is not complete.




	 
	Refer to 
	Refer to 
	Timesheets - Guidance on Correcting Entries 
	Timesheets - Guidance on Correcting Entries 

	and refer to your SSC / SSM



	 
	If these conditions are all met, the incorrect timesheet should be marked as Void on the

system and a new correct timesheet should be created which needs to be approved by the

Head Teacher and sent to Payroll.


	 
	Only SSC/SSM’s can mark timesheet records as VOID


	 
	To Void a timesheet, select the button on a record sitting at Complete.

This will change the status to VOID. Ensure that a note is added to the Void record to

provide information about the action that is being taken to resolve the issue.


	Figure
	 
	 
	Once you have created a new timesheet which corrects the error made in the original

Payroll Report and have followed the whole approval process up until the timesheet is sitting

at Complete, you will need to run a new Payroll Report only containing the new record. To

do this:


	 
	1. On Timesheet Report section of the system, select 5. Payroll Report from the drop

down list


	1. On Timesheet Report section of the system, select 5. Payroll Report from the drop

down list


	1. On Timesheet Report section of the system, select 5. Payroll Report from the drop

down list



	2. Check that the following filters are on the report:


	2. Check that the following filters are on the report:




	 
	 
	Figure
	 
	3. In the search bar, type in the teachers name who the new record has been made for


	3. In the search bar, type in the teachers name who the new record has been made for


	3. In the search bar, type in the teachers name who the new record has been made for




	 
	 
	Figure
	 
	4. Ensure that only the information relating to the correct record is showing, before

selecting Action > Download > CSV


	4. Ensure that only the information relating to the correct record is showing, before

selecting Action > Download > CSV


	4. Ensure that only the information relating to the correct record is showing, before

selecting Action > Download > CSV



	5. Check again that the report only has information about the corrected entry, then send

the report via e-mail to Payroll (with HT Approval within e-mail chain), making

mention that this is a new record that is correcting one with an error
	5. Check again that the report only has information about the corrected entry, then send

the report via e-mail to Payroll (with HT Approval within e-mail chain), making

mention that this is a new record that is correcting one with an error


	 
	 





